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Disclaimer

This document is for informational purposes only and is subject to change without notice. This document and its
contents, including the viewpoints, dates and functional content expressed herein are believed to be accurate as of its
date of publication. However, Epicor Software Corporation makes no guarantee, representations or warranties with
regard to the enclosed information and specifically disclaims any applicable implied warranties, such as fitness for a
particular purpose, merchantability, satisfactory quality or reasonable skill and care. As each user of Epicor software is
likely to be unigue in their requirements in the use of such software and their business processes, users of this document
are always advised to discuss the content of this document with their Epicor account manager. All information contained
herein is subject to change without notice and changes to this document since printing and other important information
about the software product are made or published in release notes, and you are urged to obtain the current release
notes for the software product. We welcome user comments and reserve the right to revise this publication and/or
make improvements or changes to the products or programs described in this publication at any time, without notice.
The usage of any Epicor software shall be pursuant to an Epicor end user license agreement and the performance of
any consulting services by Epicor personnel shall be pursuant to Epicor's standard services terms and conditions. Usage
of the solution(s) described in this document with other Epicor software or third party products may require the purchase
of licenses for such other products. Where any software is expressed to be compliant with local laws or requirements
in this document, such compliance is not a warranty and is based solely on Epicor's current understanding of such laws
and requirements. All laws and requirements are subject to varying interpretations as well as to change and accordingly
Epicor cannot guarantee that the software will be compliant and up to date with such changes. All statements of
platform and product compatibility in this document shall be considered individually in relation to the products referred
to in the relevant statement, i.e., where any Epicor software is stated to be compatible with one product and also
stated to be compatible with another product, it should not be interpreted that such Epicor software is compatible
with both of the products running at the same time on the same platform or environment. Additionally platform or
product compatibility may require the application of Epicor or third-party updates, patches and/or service packs and
Epicor has no responsibility for compatibility issues which may be caused by updates, patches and/or service packs
released by third parties after the date of publication of this document. Epicor® is a registered trademark and/or
trademark of Epicor Software Corporation in the United States, certain other countries and/or the EU. All other
trademarks mentioned are the property of their respective owners. Copyright © Epicor Software Corporation 2018.
All rights reserved. Not for distribution or republication. Information in this document is subject to Epicor license
agreement(s).

10.2.300
Revision: October 17, 2018 6:30 a.m.
Total pages: 86

sys.ditaval



10.2.300 Feature Highlights Contents

Contents
10.2.300 Feature Highlights..........ccoiiiir e 8
EDICOT UNIVEISITY . .ottt ettt e oot e e ettt e e et e e et e e e et e e 8
Cloud Hosting Option for ERP Application HEIP........ooviiiiiiii i 8
Cloud Hosting Option for ERP EQUCAtION COUISES........ccuiiiiiiiieiiee e 8
CoNtEXUAI VIABO HEIP. ...t 8
Package Control in Advanced Material Management and Handheld Course...........ccc.ccoovviivviieiiiccciicc, 9
Y= A=\ T g =T 1< g 1= o L PSSP 9
EDICOT FSA INTEGIATION . ..ottt e e e e et e e e e 9
Material ManAgEMENT.... ...t 11
Advanced Material ManagemMeNTt...........oooiiiiiie oo 11
PCID FUNCHONAITY . .. ettt 11
ERP Application Updates for PCID............ooiiiiiiii e 20
Move Inventory Request - Need BY Date.......c.oiiiiiiiiiii e, 30
SRIPPING / RECEIVING. ... 30
Company Configuration - Unapproved PO and Unconfirmed PO Settings............coccoovvviiiiiiiiein., 31
Miscellaneous Shipment - RMA and DMR.........oooiiiiiiiiie e, 32
RMA Disposition Entry - Return ShIpment.........oooiiiiii e, 32
PUICNASE IMIBNAGEMENT. ... ..ttt 33
Supplier Price List - Part and Subcontract Operation Attachments..........cccccooovviiiiiiiiiiiiieece, 33
Tracker Transaction HIiStOrY RANGE.......ccviiiiiii e 33
Generate Purchasing Suggestions - LOGGING TYPE.....couuiiiiiiiiiiie e, 34
Change Log for Supply Chain Programs and Trackers..........cc..ooiueiiiiii i 34
FINANCIAl MaNAgEMENT.... ..o e 35
ACCOUNTS PAYADIE.......oiii e, 35
Partial AP Deductible TaX PrOCESSING......ccu ittt 35
F A o B o= 10 1T (PSRRI 36
Automatic Matching of AP PaymeENtS..........ooiiiiiiiiiii e 36
Withholding Tax Payment REPOI.........ccuiiiiiiiieiie e 37
Withholding Tax Payment EXPOrt.........oooiiiiiiiiie e 37
ACCOUNTS RECEIVADIE. ...ttt ettt 37
ACH P aY MBS ettt 37
Automatic Matching of AR PaymeNtS........cooviiiiiiii e 37
Auto Creation of INvoice Cash RECEIPTS. .......iiiiiiiiiii e, 38
Withholding Tax Payment REPOI.........ocuiiiiiii e 38
Withholding Tax Payment EXPOrt.........oooiiiiiiiiie e 38
PAYTOIL. e 38
Payroll Electronic Deposits NACHA Bank INterface...........cccoooiiiiiiiiiiiii e 38
External Payroll INt@GIatioN. .........oouiiiiiee e 39
Column Title in Export File - Layout Configuration...............ooiiiiioiiiii e 40
Overtime Per Day Threshold Calculation for All EMPIOYEes. ..........ccvveviiiiiiieee e, 40
GENETAl LEAGET ...ttt 40

10.2.300 3



Contents 10.2.300 Feature Highlights

General Ledger Report FOr Single ACCOUNT.........uiiiiiiiiie e 40

Posting Rules Check Syntax FUNCHIONAIItY..........ooiiiiiiii i, 40

Quick Posting RUIES NaVIGatioN.........cooiiiiiiiiiiii e 40

SN IMANAGEMENT. ..ottt 41
PriNT REMITIANCE SIIPS. . ittt 41

SAIES IMANAGEMENT. ... 41
DT (<] g o - | PP PPR PRSP 42
Order IMANAGEMENT. ... ittt 44
Credit Card Processing = CRE TeSt MOTE........coiuiiiiiiiiiiie e, 44

Credit Card Processing = MUt CUMENCY......ooiiuiiiiiiie e 45

Order Entry - Clear Credit Card Order Check BOX..........uiiiiiiiiiiiieiiiiie e, 46

Order Entry - Multi-Level Capable to Promise (CTP) for Kits.........coooiiriiiiiiiieieeeeeeeeeeeee e, 46
Configurator MaANAGEMENT......... i 47
IMAGE LAYEIING ENTIY ..ot e e 48

PIcture BOX = INPUL RUIES. .. .eeiiiii et 49

EPICOr WD CONFIGUIATON....ocuiiiiiiiie e, 49

Allow Recycling of IMRP JODS........ooiiiiiii e 50
Customer Relationship ManagemeNnt.........co..iiiiiiiiii e 50
Tracker Transaction HIiSTOrY RANGE.........iiiiiiiiiiii e 51
ProdUCION IMANAGEMENT. ...ttt 52
Manufacturing EXecution SYStemM (IMES)..........oouiiiiieieoi oo 52
IMES IMIBINU SECUTTTY ..ttt ettt e et e et e e e et e e et eee e 52

JOD MANAGEMENT. ... ettt e ettt e e e 53
RETUMN GOOAS REPAIN. ... ittt 53

QUAIIEY ASSUIBNCE. .. ettt e et e e e e ettt e e e et e e e e ettt e e e e et e e e 54
RETUIMN TO CUSTOMIBY ...ttt e oottt et e e e e e e et e e e e e e e e e e 54

Material RequUIremMents Planning...........iiiiiiiiiiii e 55
Process MRP = LOGGING Ty ..ttt ettt e et e e e e e et e e e e 55

SYSTEM I ANAGEIMENT. ettt ettt e e e e ettt e e e e e e 55
SQL SecUrity Error REPOIMING . ... .. ittt e e 55
SYSTEM IMONITON REPOITS. .ttt e et e e e ettt e e e e ettt e e e e, 56
IN=APP NOTITICATIONS. ...ttt 56
) G 1] (U o PP URURRTRTPR 57
EPICOr COMMEICE COMMETT. ... et ittt ettt ettt e e ettt e e ettt e e e et ee e e 57
Upload Part Image to Epicor CommErce CONNECT.........uiiiiiiiiiiiieieiiie et 57

Menu Maintenance - Copy Security 10 Current COMPANY......couueiiiiiiiiii et 57

T aaclY Y o Td =T aTe [ Koo ] PP PP ST 58
Epicor AAministration CONSOIE.........iiiiiiii e 58

FIPS T40-2 ENCIYPTION. ..ei ittt e et e e e e e e 58

MUIIPIE EDD SIES.. . ittt 58

EPICOr ENTEIPriSE SEAICN.....ciiiiiiiiii e 58

ES Command Line Tool - Create Search INAEX.........cooiuiiiiiiiiiiiii e, 59

ERICOT Data ANAIYTICS. .. vveiiii et 59
Sales Management Content Pack - CRM Quote Pipeline DB.........cccooviiiiiiiiiiiiiccee e, 59
Materials Management Content Pack - Enhanced Inventory DB...........ccccccoiviiiiiiiiiiiiiiieeeeiieeee, 59

4 10.2.300



10.2.300 Feature Highlights Contents

Finance Management Content Pack - Financial Statements DB.............cccocviiiiiiiiiieiiiieeeeeiee e, 60
EDICOT Dat@ DISCOVEIY.....eiiiiiiiieei ettt et e ettt e et e e et e e e e 60
ComMMaANG LINE EDD.....ooiiiiii ettt 60
Data DiSCoVEry DashbOards........cc..iiiuiiiiiii i 60
EDD AQVANCEA EAITION. ... ittt ettt 61
MISC INSTAllAtiON, UX .. oo 61
EDICOT WD ACCESS. ...t 62
Routing Rules in EWA RepOrting FOMMS........oouuiiiiiiiiii e, 62
EVWA HEEPS SUDPPOIT . ..ttt e ettt e e e e e e e e 62
REPOI TOOIS. .. ettt 62
AAVANCEA Print ROUTING . ....oiiiiiiiiii et 62
Electronic Compliance Maintenance - Support XML Elements with Attribute and Value................... 64

Eit SSRS REPOITS. .. ettt 64
Replaceable REPOI LOGOS. ... ..oiiiiiiieiie e 65
Field SeCUNtY MaiNtBNANCE. .. ... veiiiie ettt e et e e, 66
Data IMASKING. ...t 66
EPICOr KINETIC Fram@WOIK .. .. vviiiiiiieiie e 66
Redesigned AcCtive HOME PAGE.........ooiiiiii e, 66
Country SPeCific FUNCHIONAIITY........c..oiiiie e, 67
Bl GIUM . e 67
Automatic Matching of AP PaymeNtS.........oouiiiiii e 67
Automatic Matching of AR PaymeENtS........ooiiiiiiiiii e 67
e = PSSR UPPRUPR 68
WY Bill FUNCHONAIITY. ...t 68
DT 10 T T PSSP UP ST 68
Automatic Matching of AP Payments........oooiiiiii e 68
Automatic Matching of AR PaymeNtS.........ooviiiiii i 69

(@ 11T T USSR 69
Booking VoUCher REPOI FOOTEI. ... ..iiiiiiiiii e, 69
(@] ol aa] o 1= TSRS 69
Lower of Cost or Net Realizable Value.........oooi i 70
EIECErONIC INVOICING . .. ettt ettt 70
CUSTOMS ClEATANCE LOTS. . ittt ettt ettt et e e e et e e e e nee e 70
DANSKEBANK ...t 70
Ly (o] o 1T FO PSSP UPRR 71
Automatic Matching of AP Payments........oooiiiiiii e 71
Automatic Matching of AR PaymeNtS........coouiiiiiiiii e 71

T 0] =T o SRR 71
Automatic Matching of AP PaymeNtS.........oouiiiiic e 71
Automatic Matching of AR PaymeENtS........ooiiiiiiiiii e 72
AOS2 Format for Nordea AP PayMentS...........cooueiiiii e 72
LT .4 T= £ 7 PP 72
Germany SPeCific Data IMPOIt........ooiiiieeee e, 72
Lookup Data IMport @nd EXPOIT.......cc.uiiiiiiiiiiie et 73
FIFO StOoCk MOVEMENT REPOI. ... eiiiiiiiiiiiie e, 73

10.2.300 >



Contents

10.2.300 Feature Highlights

Part FIFO Transaction History Tracker DE.............iiiiiiiiiiiiiiie e, 73

L IAYSIA ..t 73
Deemed SUPPIY REPOITING. . ..iiiiiiiiii ittt 73

TAX BOX 1S e 74
LDl PSSP 74
Customs UOM in Electronic International Trade CFDI Supplement XML ........ooooiiviiiiiiiiiiiiice, 74
PayMENT TraCker MX ... oot e et e e 74
Update Payment FiScal FONO IMX .. ..o, 74
CUSTOMS ClEAIANCE LOTS. . .ii ittt ettt ettt et e et et e e e e e enee e 74

L g TTg P aTo LTRSS 75
Digipoort Digital Certificate StOre..........ooviiiii e, 75

N oY =T T USRS 75
[N o] 4= PSSR 75
Automatic Matching of AP PaymeNnts.........ooiiiiiiii e 75
Automatic Matching of AR PaymeNtS........cooviiiiiii i 76
Transaction Reason Codes for Nordea Payment...........ooiiiiiiiiiiiiiiece e 76
Transaction Reason Codes for DanskeBank Payment...........cccoooiiiiiiiiiiiiiec e 76
SAF-T Financial FUNCHONAIITY. ......oc.oiiiiiiii e, 76
POMTUGALL .. e 76
CaSh RECEIPT TrACKET ...t 77
ConfIQUIAtION SETHINGS P ... e, 77
SIS OB ENTIY ..o 77
Sign and Generate Transport DOCUMENT.......ciiiiiiiiiiiiie e 77
Transaction Document Type MainteNaNCe.........iiiiiiiiiii it 77

Y TZ=T0 Lo PSSP RSP PRPP 78
Automatic Matching of AP Payments........oooiiiiii e 78
Automatic Matching of AR PaymeNtS.........ooviiiiii i 78
Regulatory Reporting Codes for Nordea AP Payment..........oooviiiiiiiiiiiiiieeee e, 78
Regulatory Reporting Codes for DanskeBank AP Payment...........cccoooiviiiiiiieiiiiieieeee e, 78
SWILZEIIANG. ... e, 78
Automatic Matching of AP PaymeNtS.........ooviiiiii e 79
Automatic Matching of AR PaymeENtS........ooiiiiiiiiii e 79
L1 L TSP RR PRSPPI 79
Lower of Cost or Net Realizable Value..........cooiiiiiii e, 79
L1212 11 = o PSP PRTRPPRRPR 80
Document Options on Monthly VAT REPOI.......ccuiiiiiiiiiii e, 80
Lower of Cost or Net Realizable Value..........ooo i 80

Part Descriptions in BOM LiStiNG REPOIT.......oiiiiiiiiiiii e 80
Withholding Taxes in Report and Certificate...........ooc.iiiiiiiiiiii e 80
UNIted KINGOOM. ..ottt 81
CIS Monthly Return Dashboard UK.............ooiiiiiiiiiiii e 81

CIS Monthly Return REPOIT UK ... ..oiiiiiiiiiei e, 81
Payment and Deduction Statement UK REPOIM........couiiiiiiiiiiiii e, 81
P U e e 81
Withholding Tax Calculation in Payment INStrument.............ooooiiiiiiiiii e 82
10.2.300



10.2.300 Feature Highlights Contents

CUSTOMS ClEAIANCE LOTS. . ittt ittt ettt ettt et e e e et e e e e nee e 82

Y [a1o =] o1 =PSSO UPP SRR 82
UOB PaymMeNt PrOCESSING ... uveiiiiiiiiie ettt ettt ettt e et e e ettt e e e e 82

(8T LC=Te Y =) =TSR 82
AP Open INvoices With 1099 Details..........oiiuiiiiiiiiiiiiiee et 83
Extension and COMPANION PrOGIamMS. ... .....iiiiiiiiiie ettt 83
ERICOr IMODIIE TRV et 83
AzUre AD AUTNENTICATION. .. ..o 83
Sales and Tax Category Options for QUOLE LINES........c...ooiiiiiiiiii e, 84
Ability to Specify Tax Liability and Tax Exempt for CUStoOmers...........ccooovviiiiiiiiiiiiieciee e 84
Ability to Create Orders from QUOTES. .........ouviiioie e 84
AdA/EAit SAIES OFUBIS. ... oo 84
Order ShIPIMENT. ..ottt 84
QU (0] g 1=T V. =T o OSSOSO 84
INVENTONY SEAICN ... ettt e et e e et 85
Discount Percentage for Opportunity/QUOTE...........oiiiiiiiii i, 85

@ c=To [} =[] Lo P PSPPSR 85
Order LINE COMMEBNTS. ...t e, 85

10.2.300



10.2.300 Feature Highlights 10.2.300 Feature Highlights

10.2.300 Feature Highlights

The following section contains a list of features released with the Epicor ERP 10.2.300 version. If you are upgrading
from a previous version, review this information to learn about the features added through this major version.

Epicor University

Epicor University creates and maintains the documentation and education materials for Epicor ERP. Note that
Embedded Education is a licensed module that only displays when the module is enabled.

Course updates include new functionality available in the product with each release.

Cloud Hosting Option for ERP Application Help

The option of using an Epicor hosted instance of ERP help is now available to on premise installations.
Epicor ERP application help is now hosted in Microsoft Azure® cloud.
Some benefits include:

e Help search is now powered by Azure search which provides more robust capabilities.

¢ On premise IT staff no longer have to maintain their own help environment (although that option is still
available).

Hosting help also enables Epicor University to gather analytics on help use from a larger segment of users. This
allows Epicor to focus on and to expand ERP help resources in areas of highest demand.

See the ERP installation guide for instructions on the help URL to use in Company Maintenance.

Cloud Hosting Option for ERP Education Courses

The option of using an Epicor hosted instance of ERP education is now available to on premise installations. ERP
education continues to require the Education module license.

On premise IT staff no longer have to maintain their own education web environment (although that option is
still available). The need to configure your own education ERP instance remains as before.

Hosting and having a central education site enables Epicor University to gather analytics on education course use
from a larger segment of users. This allows Epicor to focus on and to expand ERP education resources in areas
of highest demand.

See the ERP installation guide for instructions on the education URL to use in Company Maintenance.
Contextual Video Help

If there is a set of Epicor videos that relate to the use of a certain ERP form, that form now has a Video Help
command added to the Help menu of the form, and a video play icon added to the form toolbar.

In this release, the ERP forms that have an enabled Video Help menu are:

e AP Invoice Entry
e Job Entry

8 10.2.300
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e Job Tracker
e Purchase Order Entry
e Customer Maintenance

Launching the Video Help menu item opens a browser and displays a video playlist of videos related to the form.
The playlist is hosted on the ERP video portal page so other videos may also be accessed.

Package Control in Advanced Material Management and Handheld Course

Education on the new Package Control feature has been added to the Advanced Material Management course
and the Handheld course.

u Important To use PCID functionality, you must have an AMM license.

In the Advanced Material Management course, you learn how to set up, generate and build PCIDs, and how to
use PCIDs when performing transactions like receiving inventory, transferring and adjusting inventory, fulfilling
demand, picking and packing and manufacturing parts. You will also be able to perform workshops using the
main application, the MES and the handheld application.

In the Handheld course, you learn to perform PCID transactions on the handheld device, like reporting production
or picking inventory into a PCID. You also learn how to build, merge and split PCIDs.

For more information, refer to the Advanced Material Management and Handheld courses.

Service Management

Service management capabilities (for example, Field Service) include such areas as production and facilities
maintenance.

This suite of modules is particularly important for businesses where maintenance and repair are often more
cost-effective than new capital acquisition.

Epicor FSA Integration

The Field Service Automation module allows you to integrate Epicor ERP with Epicor FSA.
The Epicor FSA Integration includes the following updates:

¢ Requesting Material - You can request more quantity for an item that is not in a vehicle or you can increase
the existing vehicle quantities. If you request additional items in Epicor FSA, Epicor ERP automatically creates
a move inventory request that displays in the Material Request Queue.

ﬁ Note To process material move requests, you must install the Advanced Material Management license.

e Part Transaction History - The Part Transaction History Tracker References Service Order Number and Service
Order Resource Number tied to the inventory transfer executed in Epicor ERP.

When you move inventory in Epicor FSA, you process it via the Material Request Queue in Epicor ERP. Once
processed, the Service Order Number and Service Order Resource Number fields reference a service order and
its resource tied to the inventory transfer in Epicor FSA.

¢ Service Contracts - In Service Contract Entry, if you select the Sync to FSA check box, a service contract is
automatically sent to Epicor FSA without being invoiced.

10.2.300 ?
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If you synchronize a service contract in Epicor ERP it automatically becomes a Service Agreement in Epicor
FSA. In Epicor ERP, if you add a service contract renewal to the already synchronized service contract, a new
service agreement is automatically created and becomes a child of the original service agreement.

Expenses - If you add an expense in Epicor FSA, a new expense record is automatically created in Time and
Expense Entry in Epicor ERP.

When you pay the expense back to an employee or you approve/reject/delete the expense in Epicor ERP, a
notification message is automatically sent to Epicor FSA. Since the Epicor FSA integration does not support
multi-currency, the Claim Amount is the same as the Expense Amount.

Purchasing Miscellaneous Charge - You can synchronize a purchasing miscellaneous charge/credit record
with Epicor FSA.

Return Material Authorization/Disposition - Return Material Authorization and RMA Disposition Entry
include the FSA sheets used to view Epicor FSA references that relate to equipment repair/return and to
synchronize an RMA record with Epicor FSA.

Using RMA Disposition Entry, when you dispose of an RMA record that relates to Epicor FSA, a notification
message is automatically sent to Epicor FSA.

h Note You cannot dispose items to stock if an RMA record is synchronized with Epicor FSA.

The Epicor FSA integration creates RMA Receipts for serial tracked parts only if the receipt quantity equals to
one. A new RMA record is automatically created in Epicor ERP if a Performed Line with Actions is set to Remove
in Epicor FSA.

The following rules apply:
e Using RMA Disposition Entry, when you dispose of an RMA record that relates to Epicor FSA, a notification
message is automatically sent to Epicor FSA.

e |f an RMA record marked as Sync to FSA is shipped via Miscellaneous Shipment Entry and confirmed
through Stage Ship Confirm, the shipment moves to Epicor FSA.

e If a selected customer on an RMA record is synchronized with Epicor FSA, the Sync To FSA check box
defaults to selected and is active.

e |f an RMA record includes a receipt that has been disposed (partially or completely), the Sync To FSA check
box is disabled.

e [f there is an Epicor FSA Service Order or Service Order Resource tied to an RMA record, the Sync To FSA
check box is disabled.

e You cannot create Return Material Authorization (RMA) records for parts that are not marked as Equipment
on the Part Maintenance > Integrations > FSA sheet.

* You cannot dispose items to stock if an RMA record is synchronized with Epicor FSA.

e When an RMA record automatically generates as a result of adding a performed line to a service order in
Epicor FSA, the Invoice and Order fields in Return Material Authorization remain active, so you can link
the sales order that originally sold the equipment to a respective RMA record.

The following rules apply:

1. The Order/Line and Invoice fields remain active.

[ Note You cannot link a sales order or invoice lines that don't hold the same received Epicor
FSA part. If you attempt to do so, the error message displays.

2. For Epicor FSA records, the Credit related fields disable.

3. The Part and Quantity fields remain inactive and will not update based on the sales order or invoice
selection.
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e DMR Processing - Allows you to review the Epicor FSA service order number and service order resource
references that relate to the RMA record entered in Epicor FSA.

In Epicor FSA, if you add a performed line to a service order an RMA Header and Line are automatically
generated in Epicor ERP. If you financially approve the performed line in Epicor FSA, an RMA Receipt is
automatically created on the RMA record. In Epicor ERP, if you fail the RMA record, a DMR number is
automatically generated. Since the RMA carries the service order number and resource, both values are
inherited by DMR Processing.

Menu Path: Production Management > Quality Assurance > General Operations > DMR Processing
e Miscellaneous Shipment - You can synchronize a miscellaneous shipment and its line(s) with Epicor FSA.

An RMA record is automatically created in Epicor ERP as a result of setting the Performed Line with Actions
to Remove in Epicor FSA. If the RMA is tied to a job a miscellaneous shipment Pack ID is automatically created.

* Time Phase - If you generate demand through Epicor FSA by requesting additional items, Time Phased Inquiry
displays the Epicor FSA service order and service order resource numbers that relate to this demand.

e Company Setup - You can set up default Epicor FSA integration company settings that relate to Accounts
Receivable, Expenses, Incoming Labor/Material, and RMA.

You set up the necessary default data using the Modules > Services > Field Service > General/Epicor FSA
sheets.

The Material Management module refers to the approach for planning, organizing, and controlling all those
activities principally concerned with the flow of materials into an organization. The scope of material management
includes materials planning and control, purchasing, inventory control, data collection, and shipping and receiving.

Advanced Material Management (AMM) enables distributors and manufacturers to produce electronic requests
for materials, dispatch those materials, and track inventory movements of all inventory including raw materials
and work in process.

Using wireless terminals and bar coding technology, distributors and manufacturers are able to track inventory
in real-time. The Advanced Material Management module provides complete control and visibility of raw materials
and work in process as it travels throughout the enterprise.

PCID Functionality

Use Package Control functionality to track, manage, or transact a group of items via a unigue package control
ID.

Package Control functionality allows you to track an item you receive into a site or manufacture, the item's
movement throughout the site on the shop floor, through picking an order to the shipment to the customer.
The Control ID is the unique identifier against which you place these transaction types. These transactions types
include purchase order receipt transactions, production transactions, inventory movement transactions, pick
transactions, shipping transactions, and job receipt to inventory transactions, amongst others. You can also
associate these PCIDs with a set of predetermined or user-defined physical characteristics.

M Important To use PCID functionality, your company must have an AMM license.

Package Control allows you to quickly and easily manage a collection of items throughout its process life cycle.
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8 . Example Receiving personnel receives a box of 20 units of part001 at a receiving dock. They generate a
PCID and print a label for the received box and its contents. They place the label on the box. They move
the box to a warehouse and bin. Manufacturing personnel then issues the 20 units of part001 to a job. A
warehouse employee moves the box to the shop floor for the production.

Each step of this process is performed by scanning the PCID on the box and completing the transaction.
When you scan the PCID, all contents of the PCID are identified and included in the transaction. The box
and its contents are managed, moved and tracked as a unit.

Package Control functionality uses two different entities. The first entity is the package itself and its contents;
the physical package. The second entity is the identifying label. Each entity can have its own identity and process
life cycle. They each have their own rules of control, process flow, and status. This does not mean that they are
exclusive of each other. The package and the label can share rules of controls, processes, and statuses.

There are two types of PCIDs - Static and Dynamic.

e Astatic PCID is a PCID type that you associate with a container that is available for reuse, such as a tote or a
cart on the shop floor.

A dynamic PCID is a PCID that you place on a container where the PCID collapses after its use and cannot be
reused, such as a shipping box.

PCIDs can be single level or multi-level (parent) PCIDs. A single level PCID contains individual part items. A
multi-level parent PCID can contain individual items as well as other child PCIDs. PCID functionality also supports
lot control and serialized inventory. In ERP, you can have a parent PCID with nested child PCIDs up to five levels

deep.
PCID1

PCID2
PCID4 PCIDS

PCID7

PCID10

e Level 0 - PCID only (PCID1)

Level 1 - PCIDs or Parts (PCID2, PCID3, and loose parts in PCID1)

Level 2 - PCIDs or Parts (PCID4, PCID5, PCID6 and loose parts in Level 1 PCIDs)

Level 3 - PCIDs or Parts (PCID7, PCID8, PCID9 and loose parts in Level 2 PCIDs)

Level 4 - PCIDs or Parts (ex. PCID10, PCID11, PCID12 and loose parts in Level 3 PCIDs)
Level 5 - Parts only (ex. any Parts that are loose in Level 4 PCIDs)

PCID3
PCID6

PCID3 PCIDS

Q)]

PCID11 PCID12

0,
O]
Q)1

il
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If your company has an AMM license, you can define and print three types of PCID labels.

¢ GENERAL - For a dynamic PCID that collapse after its use and is not reused
e STATIC - For a Static PCIDs that is reused
e CONTENTS - Displays the contents of a PCID

Before you generate and use PCIDs, use the programs within the Epicor application, provided by the Package
Control functionality, to create PCID definitions at the company and site levels. To use PCIDs, you must first select
the Enable Package Control check box for the site in Site Configuration.

lllustration of PCID Setup Workflow

Package Type Maintenance Control ID Maintenance

- Defi — ‘box, pallet) - Define control 1D codes
efine package fype (box, pallet) - Define parameters and create segments

Package Material Type Maintenance Package Control ID Configuration

- Define material used for packaging - Define package control 1D codes
(cardboard, metal) - Set PCID attributes
' ' - Select control ID codes and define
numeric range for site
- Initialize static PCIDs
Package Code Maintenance
- Define packages
- Select package and package material type Control ID Extract Maintenance

- Define PCID segments and extract rules
to locate a PCID within a scanned barcode

Package Control Label Type Maintenance
- Create package control label types

- Define PCID label settings

- Select Package Code and Package Control ID Code

PCID Features

PCID functionality is throughout many different inventory processes. The PCID functionality in this release includes
the following features:

¢ PCID Generator - Use the PCID Generator to generate PCIDs and print PCID barcode labels. You can either
generate a PCID for a transaction or you can generate a group of PCIDs that can be used in other areas to
load inventory.

When you generate PCIDs, you can determine the number of PCIDs, the package control type, the package
control ID code, package code and part. You can also select to print PCID labels and select the label printer.

When you generate a PCID, the format is based on the format defined on the selected package control ID
configuration.

You can generate PCIDs and print labels directly from programs such as Receipt Entry or PCID
Build/Split/Merge, MES programs like Report Quantity or Handheld programs such as Work Queue. You
can also use the PCID Generator to generate PCIDs and print labels to later assign during inventory
transactions.

10.2.300 13
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Example of PCID Generator flow in Receipt Entry

Create Receipt Add Receipt Line Generate PCID
- Generate PCID button
- PCID format based

on PCID code selected for
Pkg control label type

Complete Receipt Line

- PCID placed in
warehouse and bin

- Received part gty is
within PCID

- Can print label - PCID status is STOCK

- Label based on Pkg
control label type

- Prints on selected printer

- Warehouse and Bin
default to receiving

e PCID - Build / Split / Merge - Use PCID Build/Split/Merge and handheld programs Build PCID, Split PCID
to PCID, Split PCID to Stock and Merge PCIDs to build PCIDs that contain parts or parent PCIDs that contain
PCIDs, merge two or more PCIDs into a single PCID, nest PCIDs into another PCID (up to five level deep) or
split parts from a PCID and add them to another PCID or put them back on the shelf as individual parts.

The following are simple examples of the Build PCID, Merge PCIDs, Split PCID to PCID and Split PCID to Stock
process flows:

Example of the Build PCID Process Flow

Part1 and Part2 are built from inventory into an empty PCID.

Before PCID Build After PCID Build

r )

Inventory
PCID1 PCID1

IILT
PCID2 @

Yy F,

Example of the Merge PCID Process Flow
PCID1 is merged with PCID2. All of the contents of PCID1 are placed under PCID2. PCID1 is now empty.

14 10.2.300
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Before Merge After Merge

PCID1 PCID2 PCID1 PCID2
1 1

Example of the Split PCID to PCID Process Flow
Part1 is split from PCID1 and moved to PCID2.
Note You can also split partial part quantities and child PCIDs from one PCID to another PCID.

O

Before Split PCID to PCID (Part1) After Split PCID to PCID (Part1)

PCID1 PCID2 PCID1 PCID2

H

Example of the Split PCID to Part Process Flow

Part1 and Part1 are split from PCID1 and moved to stock.

Before Split PCID to Stock After Split PCID to Stock

.

PCID1 PCID1 Warehouse / Bin
—T <

Yy F,

Package Control ID Search -To easily search for and locate PCIDs, use the Package Control ID Search to
search for and select PCIDs that match defined criteria. You can use advanced selection criteria to filter and
sort search results for PCIDs. This includes the following:

e Search by PCID and created date ranges.

o Filter results using a Part Number, Package Control ID Configuration, Pack ID, Supply Job Number,
Warehouse/Bin or whether the PCID is a top parent or partial.

15
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[ Note If you filter using a Part Number or Supply Job Number, the Search engine will ignore PCIDs
with the EMPTY status unless you specifically select them.

If you filter using a specific Bin, the Search engine will ignore PCIDs with the EMPTY status.

e Filter by Label Print Controlled status or job number
e Filter the results by PCID type and PCID status

You can select to sort the search results by PCID or Part Number

e PCID - Displays the search results sorted by the selected PCID. The PCID column defaults to the first column
in the Search Results list and only one entry displays for each PCID. The Part Number field displays the
first part number child item found for the PCID. If the PCID is empty or if the PCID contains only child
PCID, the part related fields are clear.

e Part Number - Displays the search results sorted by part number. The Part Number column defaults to
the first column in the Search Results list and a PCID entry displays for each part. If the PCID has multiple
parts, this results in multiple PCID entries, one per part number.

You can select to search by multiple PCID types and statuses. Using the Package Control ID Search window,
you can select to include Inventory, Staged, and History PCIDs. You can then further filter the search to
include only selected PCID statuses.

[ Example If you want to include only inventory PCIDs that have a status of STOCK and VOID AND
also include Staged PCIDs that have a status of ARRIVED, first select the Inventory check box. Then
you hold down the Ctrl key and select both the STOCK and VOID entries in the list. You then check
the Staged check box and select the ARRIVED entry in the list. The search results contains inventory
PCIDs with a status of STOCK and VOID and staged PCIDS with a status of ARRIVED.

You can access this search in various locations by clicking the PCID... button or by right-clicking a PCID field
and selecting Open With > Package Control ID Search from the context menu.

Receipt of PCID on a Purchase Order - Use Receipt Entry and the handheld PO Receipt program to receive
a quantity or goods or generate one or more PCIDs at receipt time to receive Stock PO Receipt items from a
purchase order and associate the PCID with these items. Shop floor employees need to be able to receive
parts and select or generate PCIDs to associate those parts with PCIDs. They also need to be directed by the
queue (warehouse teams/material queue processing) to put away the PCID built by scanning the PCID to
move the associated items into a bin.

When you receive items to the default receiving warehouse and bin, a Material Queue row is generated.

W Note Only PO receipts that are received directly to stock can be received into a PCID.

Issue Job Material - Use Issue Material and Issue Assembly in the application, MES menu and the handheld
application to issue materials and assemblies to a job directly from a PCID. This prevents shop floor employees
from needing to split PCIDS into stock before issuing job material and assemblies to a job.

Inventory Transfers - Use Inventory Transfer and the handheld Move Inventory program to transfer a
PCID and its contents from one Warehouse/Bin to a different Warehouse/Bin. Shop floor employees need to
be able to transfer PCIDs and their contents from one warehouse and bin to a different warehouse and bin
to move PCIDs to a location where they can be used to fulfill demand from orders or jobs.

Job Output by PCID - Use Report Quantity and End Activity in the MES Menu and Handheld application
to report quantity from a job into a PCID and print a PCID label and a contents PCID label for the report
quantity. You can generate a PCID directly within Report Quantity and End Activity and you can view the PCID
in the Job Tracker and Part Tracker. This allows production department employees to quickly and easily report
produced parts into PCIDs and print labels.

When you receive job receipt parts into PCIDs, the part quantities and the PCIDs into which they are received
move from WIP to Stock.
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Job Receipt to Inventory - Use Job Receipt to Inventory and WIP PCID Receipt to Inventory on the
handheld to receive finished goods from a job to a new or existing PCID in a target warehouse and bin. This
allows shop floor employees to easily receive finished goods into a PCID and build PCIDs at the end of a
production run without having to place the items in stock, then pack them into a PCID.

Note To select an existing PCID, it must have a status of WIPFG.

e Material Request Queue - Use WIP/Material Movement in the Material Request Queue, Material
Queue Manager, Process by ID and the My Material Queue and Process by ID handheld programs to
move a PCID received from a PO receipt, job production or other material queue transaction into inventory.
Use Move Inventory Request and Move Inventory on the handheld to move a PCID and its contents from
one warehouse and bin to another warehouse and bin. This allows production workers to move a PCID in its
entirety, rather than moving each of its contents individually.

Example of material request queue process flow:

WIiP/Material Movement Transaction

Receipt Entry Material Request Queue
- Generate PCID and print - Select PCID material

- PCID moves to selected
label for received parts request

- PCID is received to - Process material
selected receiving bin request

warehouse and bin

- All contents of PCID move to
warehouse and bin

When you move a PCID, all inventory information is updated for all parts, lots and serial numbers referenced
in the PCID.

Note You can also generate a PCID for parts in a WIP/Material movement transaction.

¢ Quantity Adjustment PCIDs - Use Quantity Adjustment and the Adjust Inventory handheld program
to adjust the quantity of a part within a PCID. You can adjust quantity for parts within a parent or a child
PCID and you can adjust lot tracked and serialized parts. You can also print contents labels and the PCID
Contents report for the adjusted PCID. You can include PCIDs in the Stock Status Report. With this feature,
inventory personnel can quickly and easily adjust inventory for a PCID.

Note You can only adjust the quantity of stock that already exists on a PCID. To add a part to an
1 existing PCID, use PCID Build/Split/Merge or the Build PCID handheld program.

Note You cannot print the PCID Contents Report on the handheld application.

¢ Allow Allocations from Fulfillment Workbench - Use the Fulfillment Workbench to manually and
automatically reserve and allocate PCIDs for sales orders, including cross-dock and wave picking allocation.
Use Site Configuration to select to include or exclude inventory in a PCID from allocation. When an allocation
includes both loose and PCID inventory, the Submit for Picking process writes separate Material Queue
records. Use the Material Queue Report in the Material Request Queue to view PCID material queue
activity. When you ship a parent PCID in Customer Shipment Entry, a shipment detail is generated for all
levels of the parent PCID.

Simple Fulfillment Workbench PCID Flow

10.2.300 17
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Site Configuration
- Allow Allocation of PCID Inventory selected

Order Entry
- Demand for part created

Fulfillment Workbench

- Allocate PCID inventory to fulfill sales order
- Release for picking
- PCID included in Material Queue Report

Material Request Queue
My Material Queue (HH)

- Pick PCID and parts to fulfill order
- PCID moves to shipping location

Customer Shipment Entry

Picked Orders > Ship (HH)

- Ship parts to customer

- PCID status changes to SHIPPED

7. Note If you select the Allow Allocation of PCID Inventory check box in Site Configuration you can

1 allocate PCID inventory. You can allocate full or partial quantity. When you allocate PCID inventory, a
new sequence transaction is generated in the Material Request Queue. Once you process the transaction,
the stock PCID inventory is reduced by the allocated amount.

v Example A sales order includes three lines where each line carries a different part record. Your
inventory includes a single PCID for the three parts and the PCID inventory carries enough stock
to satisfy the allocated amount. After you allocate the parts, the Material Request Queue generates
a single sequence transaction to satisfy the allocation. When process the transaction, the Epicor
ERP application will behind the scenes process all the lines and make it ready for shipment.

Inventory Count - Include all level of PCIDs in full and cycle inventory counts. You can include parts and
PCIDs in the same count. The business flow for cycle count is the following:

¢ In Initialize Physical Inventory, select to include or exclude PCIDs in the count. The default is to include
PCIDs.

¢ In Cycle Count Part / PCID Selection Update, select PCIDs to include in the cycle count. You can also
move the PCIDs to another cycle.

¢ In Cycle Count Maintenance, view parts and PCIDs selected for the count. Generate and print tags and
start the count.

¢ In Count Tag Entry, enter count quantity for PCIDs in the PCID sheet. The counted quantity for the parts
nested within the PCID are recorded.

¢ In Count Cycle Maintenance, post the count and view inventory reports.

Filter serial and lot search screens by PCID - Filter records that appear in the Serial Selection and Lot Search
screens by PCID.

Package Control Related Programs

The following PCID related programs are available for use if you have an AMM license:
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[ Note To use PCID functionality at a site, you must also have the Package Control Enabled check box

selected for the site in Site Configuration.

Setup programs:

Handheld / MES Menu Security Maintenance - Define role-based access to MES and Handheld menu
items.

Package Type Maintenance - Define package type codes that represent user-defined packaging classification
types (for example, cardboard box, shipping container, pallet) you can assign to specific packaging codes
defined in Packaging Code Maintenance

Package Material Type - Define the types of materials that your company uses for their packaging. After
you define a material type, you can then assign it to a Package Code.

Package Code Maintenance - Define package codes that denote various kinds of shipping containers (for
example, 8 x 10 Container, Multi-Unit Box).

Control ID Maintenance - Create Control IDs, determine their ranges, and define how the Control ID
segments generate at the company level that are subscribed to at the site level.

Control ID Extract Maintenance - Define the rules that determine what to extract from a barcode to create
the PCID.

Package Control ID Configuration - Create static and dynamic Package Control ID Codes, define attributes
and assign a portion of a range of a Control ID to the PCID (Package Control ID) for the current site.

Package Control Label Type - Define Static, General and Contents label types that determine the PCID
number that generates for the selected label type and the label format that prints at a site. Specify the number
of labels to print, the report location, and a PCID code. You can also associate a Package Code with a label
type to specify a label type's package attributes. When PCIDs generate, it looks at the values define in the
Package Control ID Code, Number of Labels to Print, and Report Style fields and uses these values to
determine the PCID number that generates onto the label, the number of labels that print, and the label
format to use.

General Operations Programs:

Package Control ID Maintenance - Modify and view a PCID and its content, activities, packaging, labels,
and customer container information. View the current status, prior status, and labeling specifications for a
PCID. If a label is associated with a PCID, you can view the label's current status and attributes and reprint
labels.

Package Return Adjustments - Adjust returnable package container on-hand quantities (for a selected
internal part, customer container part or package code) in designated warehouse bins.

PCID Build/Split/Merge - Build, split or merge PCIDs. You can build PCIDs that contain parts, or parent
PCIDs that contain child PCIDs, merge two or more PCIDs into a single PCID, nest PCIDs into another PCID
or split parts from a PCID and add them to another PCID. You can also return parts in a PCID to inventory.

PCID Generator - Generate Static and Dynamic PCIDs and print PCID barcode labels.
Void PCID / Label - Void a dynamic or a static PCID.

Package Control ID Parent Child Tracker - View high level information about selected Package Control IDs
(PCIDs); this includes information about parent and child relationships as well as current location and quantity.

Reports:

10.2.300

PCID Contents Report - Display all parts and child PCIDs contained in PCIDs. You can select to include both
inventory and staged PCIDS in the report or select to display only inventory or staged PCIDs. You can also
select to reprint PCID labels for the included PCIDs.

The PCID Contents Report includes the Label Printer field where you can specify a printer to print Reports
and Labels or just Labels.

W Note The field activates if you select the Labels or Report and Labels options in the Print field.
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Handheld PCID Programs

Build PCID - Add parts and PCIDs from stock to a PCID.

Merge PCIDs - Move the full contents of one PCID to another PCID.

Split PCID to PCID - Remove a part or a child PCID from one PCID and move it to another PCID.
Split PCID to Stock - Remove a part or a child PCID from one PCID and move it to stock.

Package Return Adjust - Adjust returnable package container on-hand quantities (for a selected internal
part, customer container part or package code) in designated warehouse bins.

Void PCID / Label - VVoid a PCID and its label information.

WIP PCID Receipt to Inventory - Assign WIP PCIDs generated from supply job output to an inventory
warehouse and bin.

ERP Application Updates for PCID

This feature covers the following areas in the Epicor ERP application:

PCID Setup

Site Configuration - The Void When Emptied check box was added to the Modules > AMM > Package
Control sheet to automatically void a dynamic PCID when it becomes empty. You can only void a dynamic
PCID for which you selected the Allow Void check box in the Package Control ID Configuration.

The Allow Allocation of PCID Inventory check box was added to the AMM > Fulfillment Workbench
sheet to determine if inventory in PCIDS should be including in manual and automatic allocation in Fulfillment
Workbench.

Menu Path: System Setup > Company > Site Maintenance > Company Configuration

Warehouse Maintenance - A Warehouse Printer sheet was added. In the Warehouse Printer sheet,
select a pre-existing printer that you wish to assign to a warehouse, specify the display order of a warehouse's
printers and determine if a printer is a default printer for a warehouse.

Menu Path: Material Management > Inventory Management > Setup > Warehouse

Employee Maintenance - The Package Control sheet has been renamed to Advanced Package Control.
If your company does not have an Advanced Package Control license, the fields on the Advanced Package
Control sheet are disabled.

Menu Path: Material Management > Inventory Management > Setup > Employee

Package Control Label Type Maintenance - A new CONTENTS label type was added and is available if
you have an AMM license. If the CONTENTS label type is selected, the Number of Labels to Print, Report
Style, Style Number and Report ID fields are available. All other fields are disabled.

Menu Path: Material Management > Advanced Material Management > Setup > Package Control Label Type

Package Control ID Configuration - An Outbound Container field was added to the Detail and List
sheets to indicate if the package control ID configuration is an outbound container. This field is enabled for
dynamic labels and disabled for static labels.

e |f the package control ID configuration is set as an Outbound Container and the site is set as Outbound
Serial Tracking in Site Configuration, when a serial-tracked part is added to a PCID using the package
control ID configuration, serial numbers must be selected for the quantity.

* |f a package control ID configuration is set as an outbound container and a lot-tracked part is added to a
PCID using the package control ID configuration, a prompt appears for lot attributes.

A Control ID Code field was added to the Detail and List sheets to enter the unique Control ID code to
which you want to subscribe at the site level for a static PCID. You can then assign a portion of the available
range to the current site. You define these Control ID codes at the company level in Control ID Maintenance
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The Warehouse and Bin fields now have context menus. Right-click the Warehouse field to launch
Warehouse Entry or Warehouse Search. Right-click the Bin field to launch Warehouse Bin Entry or
Warehouse Bin Search.

Menu Path: Material Management > Advanced Material Management > Setup > Package Control ID
Configuration

[ Note If a PCID is in both the Inventory and Staged table, staged header information displays and Staged

appears in Record Type fields and Status indicators.

For PCID Generator

PCID Generator - The PCID Generator Program was added to allow you to generate PCIDs and print PCID
barcode labels that can later be assigned during inventory transactions.

Menu Path: Material Management > Advanced Material Management > General Operations > PCID Generator

Package Control ID Maintenance - A PCID that was written into history and then re-used now can be
selected.

An Outbound Container field has been added to the PCID sheet to indicate if the package control ID
configuration is an outbound container. This check box is display only. The value defaults from the setting
you assign to the selected PCID in Package Control ID Configuration.

You can launch the PCID Contents Report by clicking Actions > PCID Contents Report.

Menu Path: Material Management > Advanced Material Management > Setup > Package Control ID
Maintenance

PCID Generator (MES) - The PCID Generator was added to the MES menu.
MES Menu Path: MES Menu > Supervisor > PCID Generator

For PCID Build / Split / Merge

10.2.300

PCID Build/Split/Merge - PCID Build/Split/Merge was added to allow you to build, split or merge PCIDs. You
can also generate PCIDs and select serial numbers.

You can build, split or merge the contents of PCIDs to and from other PCIDs and to and from inventory.

e On the PCID Build/Split/Merge sheet, you can build, split or merge contents to and from PCIDs. You
can build PCIDs and add parts and child PCIDs to it. You can move parts and child PCIDs from one PCID
to another PCID. You can also remove parts or child PCIDs from another PCID.

® On the To/From Inventory sheet, you can add or remove PCID contents to and from inventory. You can
remove parts from stock and add them to a PCID. You can remove parts from a PCID to inventory as
individual parts. You can also remove a child PCID from a parent PCID and return it to inventory.

You can launch the PCID Contents Report for a destination PCID by clicking Actions > PCID Contents
Report.

Menu Path: Material Management > Advanced Material Management > General Operations > PCID
Build/Split/Merge

Package Control ID Parent Child Tracker - You can launch the PCID Contents Report by clicking Actions
> PCID Contents Report.

Menu Path: Material Management > Advanced Material Management > General Operations > Package
Control ID Parent Child Tracker

PCID Contents Report - A PCID Contents Report has been added to display all parts and child PCIDs contained
in a PCID. You can select to include both inventory and staged PCIDS in the report or select to display only
inventory or staged PCIDs. You can select to print only the PCID Contents Report, only PCID labels for the
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included PCIDs or print both the report and the PCID labels. You can also select to include empty PCIDS in
the report or use filters to only include selected PCIDs.

W Note Voided PCIDs do not appear in this report.

Menu Path: Material Management > Advanced Material Management > Reports > PCID Contents

Serial Number Maintenance - You can now change the PCID associated with a serial number. You can
enter or scan the PCID or search for the PCID using PCID Search.

Menu Path: Material Management > Inventory Management > Setup > Serial Number Maintenance
PCID Build / Split / Merge (MES) - The PCID Build / Split / Merge programs was added to the MES menu.
MES Menu Path: MES Menu > Supervisor > Build / Split / Merge

Build PCID (Handheld) - A Build PCID program was added to the Handheld application to allow you to add
parts and PCIDs from stock to a PCID.

Menu Path: Package Control > PCID Maintenance > Build / Split / Merge > Build PCID

Merge PCID (Handheld) - A Merge PCID program was added to the Handheld application to allow you to
move the full contents from one PCID to another PCID.

Menu Path: Package Control > PCID Maintenance > Build / Split / Merge > Merge PCID

Split PCID to PCID (Handheld) - A Split PCID to PCID program was added to the Handheld application to
allow you to move a part quantity or child PCID from one PCID to another PCID.

Menu Path: Package Control > PCID Maintenance > Build / Split / Merge > Split PCID to PCID

Split PCID to Stock (Handheld) - A Split PCID to Stock program was added to the Handheld application
to allow you to remove a part quantity or child PCID from PCID and add it to stock.

Menu Path: Package Control > PCID Maintenance > Build / Split / Merge > Split PCID to Stock

For Receipt of PCID on a Purchase Order

Receipt Entry - PCID fields were added to Location pane of the Lines > Detail sheet to allow you to select
or generate a PCID for a receipt line. The following fields appear:
e PCID button - Select and search for a PCID to associate it with the receipt line.

e PCID - Specifies the PCID associated with the receipt line. When you enter, scan or select a PCID, you
extract the internal PCID from the full PCID string, validate the package control status and validate that
the PCID is valid for this receipt.

e Generate PCID button - Click this button to generate one or more PCIDs for the receipt line. A PCID
generator launches where you can generate a PCID for the receipt line.

PCID fields were added to the Actions > Mass Receipts sheet to allow you to generate one or more PCIDS
for the received receipt lines. The following fields appear:
® PCID - Specifies the PCID associated with the receipt line.

* Generate Single PCID - Generates a single PCID for the receipt and automatically assign it to all lines in
the receipt.

e Generate Multiple PCIDs - Generates a PCID for each line in the receipt . Each PCID in the receipt must
be scanned to indicate which line is being received to which PCID.

A PCID column was added to the Lines > List, Summary > Arrived Lines, Summary > Received Lines
and Summary > Arrived Lines lists.
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A PCID and PCID Barcode field was added to the Receipt Labels report to include PCIDs and PCID barcodes
on receipt labels. You can also include PCID contents such as the part, unit of measure and lot on printed
Bartender labels that have a label type of General.

A PCID field was added to the Inventory Movement report to include PCIDs for receipt lines.

A PCID and PCID Barcode field was added to the Material Tags report to include PCIDs and PCID barcodes
on material tags.

h Note You can only select or generate a PCID for a receipt line if the following information is true:
L]

Your company has an AMM license

e The purchase order type is Standard and the Purchase Order Line Type is Stock or Miscellaneous
with an Inventory transaction type.

e The purchase order release is not set to Buy to Order.

¢ The purchase order is not supplier or customer managed
e The receipt line Inspection Required check box is clear.
e There is no link to a planning contract.

¢ The Received check box for the receipt line is clear.

h Note You can only enter and search for PCIDs that have the following criteria:

e Ininventory (not history or WIP)
¢ In the current company and site
e The PCID warehouse matches the warehouse for the receipt line

Menu Path: Material Management > Shipping / Receiving > General Operations > Receipt Entry

e Package Control ID Maintenance - If a PCID exists in both the Staged and Inventory tables, the PCID Status
indicator displays Staged and the header screen is populated with the Staged header information.

A Record Type field was added to the Items > Detail and Items > List sheets to display the PCID item's
header status. The status can be Inventory, Staged or History.

Menu Path: Material Management > Advanced Material Management > General Operations > Package
Control ID

e Package Control ID Parent Child Tracker - A Record Type was added to displays the parent PCID item's
status.

Menu Path: Material Management > Advanced Material Management > General Operations > Package
Control ID Parent Child Tracker

¢ PO Receipt (Handheld) - Receive To PCID button and the associated screen were added to the handheld
PO Receipt program to streamline receipt of items onto a PCID.

Menu Path: Material Management > Data Collection > Handheld > Shipping/Receiving > PO Receipt

For Issue Job Material

e Issue Assembly - A PCID selector and field have been added to the Detail and List sheets to allow you to
select or enter a PCID from which to issue parts to a job assembly sequence.

[ Note To issue from a PCID to an assembly, the PCID status must be Stock, the PCID must not be the
child of another PCID, the PCID must exist in the current site or a shared warehouse, your company
must have an AMM license and the Enable Package Control check box must be selected for the site
in Site Configuration

Menu Path: Material Management > Advanced Material Management > General Operations > Issue Assembly
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Issue Material - A PCID selector and field have been added to the Detail and List sheets to allow you to
select or enter a PCID to from which to issue materials to a job.

[ Note To issue from a PCID to a job, the PCID status must be Stock, the PCID must not be the child of
another PCID, the PCID must exist in the current site or a shared warehouse, your company must have
an AMM license and the Enable Package Control check box must be selected for the site in Site
Configuration

Menu Path: Material Management > Advanced Material Management > General Operations > Issue Material

Job Pick List Report - The report now includes PCIDs. Under each warehouse and part, the report displays
a list of PCIDs that include the part.

Menu Path: Material Management > Inventory Management > Reports > Job Pick List

Issue Assembly (Handheld) - A PCID field has been added to allow you enter a PCID from which to issue
parts to a job assembly sequence.

[ Note To issue from a PCID to an assembly, the PCID status must be Stock, the PCID must not be the
child of another PCID, the PCID must exist in the current site or a shared warehouse, your company
must have an AMM license and the Enable Package Control check box must be selected for the site
in Site Configuration

Menu Path: Material Handling > Outbound Process > Issue Assembly

Issue Material (Handheld) - A PCID field has been added to allow you to enter a PCID from which to issue
parts.

[ Note To issue from a PCID, the PCID status must be Stock, the PCID must not be the child of another
PCID, the PCID must exist in the current site or a shared warehouse, your company must have an AMM
license and the Enable Package Control check box must be selected for the site in Site Configuration

Menu Path: Material Handling > Outbound Process > Issue Material

For Inventory Transfers

Inventory Transfer - A PCID field has been added. You can select a PCID or a part to transfer. A List sheet
was added to allow users to copy from a spreadsheet and transfer a list of parts or PCIDS. Selected and
transferred PCIDs display in the Inventory Transfers tree selector.

Menu Path: Material Management > Inventory Management > General Operations > Inventory Transfer

Move Inventory Request - A PCID selector and field have been added to allow you to move a PCID from
one warehouse and bin to another warehouse and bin.

Specifies the PCID that is being moved.

[ Note The PCID field is only enabled if your company has an AMM license, the Enable Package Control
check box is selected in Site Configuration, the PCID has a status of Stock and the Part field is clear.

[ Note When you attempt to move a PCID that contains serial-tracked parts, different actions occur
based on the serial tracking type of the From and To sites:

¢ If the PCID with serial-tracked parts is being moved from a site that does no serial tracking to a site
that performs full tracking, an error displays and you cannot continue.

e |f the PCID with serial-tracked parts is being moved from a site that does outbound tracking to a
site that performs full tracking and the Outbound Container check box is clear for the PCID, an
error displays and you cannot continue.

¢ If the PCID with serial-tracked parts moves from a site that does full serial tracking to a site that
performs no tracking, all serial numbers are voided.
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If the PCID with serial-tracked parts moves from a site that does no serial tracking to a site that
performs outbound serial tracking, the Outbound Container check box for the PCID is automatically
selected.

If the PCID with serial-tracked parts moves from a site that does outbound serial tracking to a site
that performs no serial tracking, all serial numbers are voided and the Outbound Container check
box for the PCID is automatically selected.

If the PCID with serial-tracked parts moves from a site that does no serial tracking to a site that
performs outbound serial tracking, no additional actions occur.

Menu Path: Material Management > Advanced Material Management > General Operations >Move Inventory

Request

¢ Move Inventory (Handheld) - A PCID field has been added to display the PCID for the transaction.

Menu Path: Material Handling > Inventory Process > Move Inventory

For Job Output by PCID

e Job Tracker - A PCID field has been added to the Part Locations > WIP sheet to display PCIDs for the WIP
part in the job operation.

Menu Path: Production Management > Job Management > General Operations > Job Tracker

e Part Tracker - A PCID field has been added to the On Hand > Part Locations > WIP sheet to display PCIDs
for the WIP parts.

Menu Path: Material Management > Inventory Management > General Operations > Part Tracker

e Report Quantity (MES) and End Labor Activity (MES) - PCID fields have been added to allow you to
generate, enter or select PCIDs for the part quantity. You can also select lot numbers or serials for the PCID.
The following fields were added:

* Generate PCID - Click this button to generate one or more PCIDs for the part quantity. When you click
this button, the PCID Generator launches. The Part, Description and Warehouse fields are populated
with the current part, description and the warehouse. The fields are view only.

e PCID - Specifies the PCID associated with the report quantity. WWhen you enter, scan or select a PCID, you
extract the internal PCID from the full PCID string, validate the package control status and validate that
the PCID is valid for this report quantity.

e Lot - Specifies the lot number to be added to the PCID. You can enter or select a lot number.

e Next Lot - Click this button to generate and select the next sequential lot number.

e PCID Contents - If the check box is selected, a PCID contents label prints for the entered PCID after the
reported quantity process.

u Note The PCID fields are only enabled if the following information is true:

Your company has an AMM license.
The Package Control Enabled check box is selected for the site in Site Configuration.

The operation against which the quantity is reported is selected as the last operation or the last
operation in the method.

The report quantity is greater than zero.
The activity is a production activity (not indirect, setup or rework).
The operation is not set to Auto Receive.

The Material Queue Report now includes PCIDs.

MES Menu Path: MES Menu > Production > Report Quantity

10.2.300
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MES Menu Path: MES Menu > End Activity

Work Queue (Handheld) - PCID fields have been added to the Report Qty and End Labor Activity screens
to allow you to generate, enter or select PCIDs for the part quantity. You can also select lot numbers for the
PCID. The following fields were added:

e Gen PCID F4 - Click this button or press F4 to generate one or more PCIDs for the report quantity. The
PCID generator launches.

e PCID - Specifies the PCID associated with the report quantity.

e Lot - Specifies the lot number to be added to the PCID.

® No Print PCID / Print PCID F3 - Print the PCID label when the transaction completes. The indicator changes
from No Print PCID to Print PCID. The label format is based on the Package Control Label Type for
the PCID.

Menu Path: Labor > Work Queue

For Job Receipt to Inventory

For Job Receipt to Inventory

Job Receipt to Inventory - A PCID Receipt sheet was added to allow you to receipt PCIDs created through
job output into inventory. When you receive a PCID, all contents in the PCID are moved into inventory. You
can select multiple PCIDs and receive them all at once.

A PCID field was added to the List sheet to display the job output PCID moved into inventory and the Detail
sheet has been renamed to the Job Receipt sheet.

Menu Path: Material Management > Inventory Management > General Operations > Job Receipt to Inventory

WIP PCID Receipt to Inventory (Handheld) - A WIP PCID Receipt to Inventory program was added to
the Handheld application to allow you to assign a WIP PCID or a range of WIP PCIDs generated from supply
job output to an inventory warehouse and bin. When you receive a PCID to inventory, the PCID status changes
from a status of WIPFG to STOCK.

Menu Path: Material Handling > Inbound Process > WIP PCID Receipt to Inventory

For Material Request Queue

Material Request Queue - A Last Used PCID field has been added to display the last PCID used when
partially processing the selected line. When you process the rest of the line, this PCID defaults on the
WIP/Material movement.

In the WIP/Material Movement Transaction screen, if you process a parent PCID, the PCID, Part, Quantity,
Lot Number fields are disabled. The Gen PCID and Serial No buttons are also disabled.

8 Note Refer to the Move Inventory Request topic for information on attempting to move a PCID that
contains serial-tracked parts. The same rules apply to this transaction.

[ Note If you are in a site is set to perform outbound serial tracking and you are picking a serial-tracked
part into a PCID that is an outbound container, you are prompted to enter a serial number.

In the WIP/Material Movement Transaction screen, the Generate PCID button launches the PCID
Generator window where you can generate PCID(s) and print label(s) for the transaction.

A From PCID field was added in the WIP/Material Movement Transaction screen to fulfill a material request
from a PCID.

The Material Queue Report now includes PCIDs.

A From PCID and a To PCID column was added to the Unselected and My Selections list to display the
PCID if a material request is from a PCID or to a PCID.
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If a Submit for Picking request is sent from Fulfillment Workbench, there are separate material queue records
when the allocation includes both inventory and PCID inventory, one for the inventory and one for PCID
inventory.

Menu Path: Material Management > Advanced Material Management > General Operations > Material
Request Queue

Material Queue (Handheld) - A PCID field has been added. You can select a PCID or a part to add to My
Material Queue.

Menu Path: Material Handling > Material Queue

My Material Queue (Handheld) - A PCID field has been added to display the PCID for the transaction. In
the Process Mtl Queue screen, if you process a parent PCID, the PCID, Part, Quantity, Lot, From Whse
and Bin fields are disabled. The Gen PCID and Serial No buttons are also disabled.

Menu Path: Material Handling > My Material Queue

For Quantity Adjustment PCIDs

Quantity Adjustment - A PCID field has been added to allow you to select a PCID and adjust the quantities
of selected parts within that PCID. The contents of the selected PCID appear in the Warehouse Bins list.
Select a part in the list to adjust the part quantity. Right-click the PCID field to launch PCID Build/Split Merge
to make additional changes to a selected PCID. When you exit PCID Build/Split’/Merge, Quantity Adjustment
refreshes to include the changes.

You can launch the PCID Contents Report by clicking Actions > PCID Contents Report.

An Open With > PCID Build/Split/Merge context menu option was added to the Part field. Right-click the
PCID field to launch PCID Build/Split Merge to make additional changes. When you exit PCID Build/Split/Merge,
Quantity Adjustment refreshes to include the changes.

A new Item PCID field was added to the Warehouse bins list to identify a child PCID within the parent PCID.
To change the PCID selection from the parent PCID to a child PCID within the parent PCID, right-click the
Item PCID column for the child PCID and select Quantity Adjustment from the context menu. The value
in the Selection PCID field changes from the parent PCID to the child PCID.

Menu Path: Material Management > Inventory Management > General Operations > Quantity Adjustment

Stock Status Report - An Include PCID check box has been added to allow you to include PCIDs in the
report.

Menu Path: Material Management > Inventory Management > Reports > Stock Status

Adjust Inventory (Handheld) - A PCID field has been added to allow you to adjust the inventory of a part
within a PCID.

Menu Path: Material Handling > Inventory Process > Move Inventory

For Inventory Count

10.2.300

Count Cycle Maintenance - The PCIDs tab has been added to display data for the top-level PCIDs assigned
to the selected cycle sequence.

By default, the application generates tags for top-level PCIDs. You can include nested PCIDs or parts in the
tags generation process by selecting the Nested PCID/Item check box in the Generate Count Tags window.

If you want to generate blank tag records for PCIDs, you need to specify the number of tags in the Number
of Blank PCID Tags field in the Generate Count Tags window.

The PCID tab has been added to the Count Cycle Void Blank Tags window to void unused blank PCID tags.

Use the Start Count Sequence, Reverse Start Count and Cancel Cycle commands on the Actions menu
to start, reverse or cancel count sequence for PCIDs for the selected cycle sequence or full physical inventory.

27



10.2.300 Feature Highlights 10.2.300 Feature Highlights

28

Use the Void Tags by PCID option on the Actions menu to remove a PCID from a cycle if count tags or
sheets have already been generated using the Generate Tags selection. The application will void all cycle
count tags generated for the selected top-level PCID in the specified cycle sequence, mark the PCID as voided
and move it to the next scheduled cycle (nested PCIDs will not get moved to the next cycle).

The Print PCID Blank Tags check box has been added to the Print Tags and Reprint Tags windows to
print/reprint blank tags generated for PCID.

The Print Nested PCID / Item Qty Tags check box has been added to the Print Tags and Reprint Tags
windows to allow print/reprint of PCID tags for nested PCIDs and item part quantities.

The Include PCID check box has been added to the Count Variance Serial Number Report, Count Parts
Not Selected Report and Unreturned/Voided Tags Report to indicate that PCIDs should be included in
these reports.

The PCID Count Report has been added to display all level or top-level PCIDs in a cycle sequence and to
calculate variances between the per-count snapshot quantity and counted quantities for PCIDs in a specified
count cycle for a specified warehouse, year, and cycle period.

Menu Path: Material Management > Inventory Management > General Operations > Count Cycle Maintenance

Cycle Count Tracker - The PCID sheet and accompanying tabs were added to Cycle Count Tracker to display
information related to scheduled cycle count or physical inventory sequences associated with PCIDs.

Menu Path: Material Management > Inventory Management > General Operations > Cycle Count Tracker.

Count Tag Entry - The PCID Detail sheet has been added to allow update of open count PCID tags and add
blank PCID tags for the selected cycle sequence.

[ Note This is only available if the cycle sequence has not been posted yet using the Post Counts selection
in the Count Cycle Maintenance Actions menu.

The Generate Blank Count Tags and Generate Lower Nested PCID/Item Tags commands have been
added to the Actions menu to allow generation of blank tags from the Count Tag Entry program and to
include nested PCIDs or parts in the tag generation process for the selected cycle sequence

Menu Path: Material Management > Inventory Management > General Operations > Count Tag Entry

Count Entry (Handheld) - The PCID related fields have been added to the HH Count Entry program to allow
update of open count PCID tags and add blank PCID tags for the selected cycle sequence.

Menu Path: Material Management > Data Collection > Handheld > Material Handling > Count Entry

Cycle Count Schedule Maintenance - The Total PCIDs field has been added to the Cycle Count Schedule
Cycles grid in the Cycles sheet to display the total number of top level PCIDs selected for this cycle count
sequence.

[ Note This field is only enabled if your company has an AMM license, the Enable Package Control
check box is selected for the site in Site Configuration, the PCID has a status of Stock, the PCID is not
a child, and the Exclude PCID Parts check box is clear in the Initialize Physical Inventory program.

Menu Path: Material Management > Inventory Management > General Operations > Cycle Count Schedule
Maintenance

Initialize Physical Inventory - The Exclude PCID Parts check box has been added to the Selection sheet
to exclude parts associated with a PCID from inventory counts.

By default, parts associated with a PCID are included in inventory counts if the following is true:

e Your company has an AMM license.

¢ The Enable Package Control check box is selected for the current site in Site Configuration.
e The PCID status is Stock.

e The PCID is not a child.
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Menu Path: Material Management > Inventory Management > General Operations > Initialize Physical
Inventory

Cycle Count Part / PCID Selection Update - The PCID tab and New PCID selection on the New menu
have been added to allow update of count cycle sequence by removing PCIDs assigned to this cycle, adding
new PCIDs, or adding existing PCIDs which have not yet been assigned to any cycle sequence.

Menu Path: Material Management > Inventory Management > General Operations > Cycle Count Part/PCID
Selection Update

Count Cycle Parts Selected - The Include PCID check box has been added to the Selection sheet to indicate
that PCIDs should be included in this report.

Menu Path: Material Management > Inventory Management > Reports > Count Cycle Parts Selected

For Allow Allocation from Fulfillment Workbench

10.2.300

Allocation Template Maintenance - Additional options have been added to the Search Sort field to allow
you to sort by PCID first.

e PCID First In First Out - Sorts results by the PCID Create Date, then by PCID, then by bin number. Inventory
not in a PCID is sorted by bin in descending order.

[ Note Allocate from the available inventory by the PkgControlHeader.CreatedDate,
PkgControlHeader.BinNum, PartBin.PCID (if multiple PCIDs have the same create date, they will be
pulled by Bin Ascending, if multiple PCIDs within the same bin have the same create date, they will
be pulled alphabetically by PCID), after that, allocate inventory not in a PCID sorted by BinNum
descending.

e PCID First - Bin Ascending - Sorts results by inventory in a PCID first, sorted by bin in ascending order.
Then sorts results by inventory NOT in a PCID, sorted by bin in ascending order.

e PCID First - Bin Descending - Sorts results by inventory in a PCID first, sorted by bin in descending order.
Then sorts results by inventory NOT in a PCID, sorted by bin in descending order.

e PCID First - Quantity Ascending - Sorts results by inventory in a PCID first, sorted by quantity on hand
in ascending order, then by PCID. Then sorts results by inventory NOT in a PCID, sorted by quantity on
hand in ascending order.

e PCID First - Quantity Descending - Sorts results by inventory in a PCID first, sorted by quantity on hand
in descending order, then by PCID. Then sorts results by inventory NOT in a PCID, sorted by quantity on
hand in descending order.

" Note Use the Site Configuration > Modules > AMM > Fulfillment Workbench sheet to define
the default values for how quantity search results for transfer orders, jobs, and sales orders are sorted
within Fulfillment Workbench for the selected site.

Menu Path: Material Management > Inventory Management > Setup > Allocation Template

Fulfillment Workbench - All Available Inventory and Available Quantity fields were updated to consider
the Allow Allocation of PCID Inventory check box in Site Configuration. If the check box is selected,
inventory that exists in PCIDs is included in Available inventory in Fulfillment Workbench and the inventory
is picked during automatic (allocate by part) or manual allocation (allocate by lot/bin). Inventory in PCIDs is
also included in cross dock and wave picking allocations.

Additional sort options have been added in Ad Hoc Allocation to allow you to sort by PCID first. For more
information, refer to the Allocation Template Maintenance update.

Menu Path: Material Management > Advanced Material Management > General Operations > Fulfillment
Workbench

Material Queue Manager - A From PCID and a To PCID column was added to display the PCID if a material
request is from a PCID or to a PCID.
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Menu Path: Material Management > Advanced Material Management > General Operations > Material
Queue Manager

* Process by PCID - A from PCID field was added to specify the PCID from which the material will be issued.

Menu Path: Material Management > Advanced Material Management > General Operations > Process by
ID

e Customer Shipment Entry - You can include PCID contents such as the part, unit of measure and lot on
printed Bartender labels that have a label type of General.

Menu Path: Material Management > Shipping / Receiving > General Operations > Customer Shipment Entry

e Material Queue (Handheld) - A from PCID field was added to display the PCID from which the WIP/material
will be issued.

Menu Path: Material Handling > Material Queue

e My Material Queue (Handheld) - A from PCID field was added to display the PCID from which the
WIP/material will be issued. A from PCID field was added to the Process Mtl Queue screen to specify the
PCID from which the WIP/material will be issued.

Menu Path: Material Handling > My Material Queue

* Process by ID (Handheld) - A from PCID field was added to the Process Mtl Queue screen to specify the
PCID from which the WIP/material will be issued.

Menu Path: Material Handling > Process By ID

¢ Auto Select Transactions (Handheld) - A from PCID field was added to the Process Mtl Queue screen
to specify the PCID from which the WIP/material will be issued.

Menu Path: Material Handling > Auto Select Trans

Move Inventory Request - Need By Date

Move Inventory Request includes the Need By date where you can specify a supply material date. The entered
date is taken into consideration when processing a material request.

Business Scenario

As a service technician you need to know the material supply date.

Menu Path: Material Management > Advanced Material Management > General Operations > Move Inventory
Request

Use the Shipping / Receiving module to monitor incoming and outgoing part quantities, whether they are
shipments against an order, subcontract parts sent to a supplier, raw material received from a purchase order to
a job or into inventory, or filling a sales order from stock.

Through this functionality, you can perform and track all activity relating to shipments and receipts.

Online transaction processing promotes efficiency and ease of use, while online editing promotes accuracy. With
Shipping / Receiving, a consistent interface processes all shipments and receipts in an efficient, accurate, and
cost-effective manner.
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Company Configuration - Unapproved PO and Unconfirmed PO Settings

Use the Unapproved PO and Unconfirmed PO fields in the Company Configuration > Modules > Materials
> Shipping Receiving sheet to determine what actions should be performed when receipts are created for
unapproved or unconfirmed purchase orders in Receipt Entry or PO Receipt (Handheld).

Shipping and Receiving clerks need the ability to be warned or stopped when receiving a purchase order that is
not approved or is not confirmed, so that appropriate actions are taken internally to address the status of the
purchase order.

The following fields have been added to Company Configuration to implement this feature:

e Unapproved PO - Specifies what should happen when receipts are created for purchase orders that are
unapproved in Receipt Entry or PO Receipt on the handheld.

¢ Unconfirmed PO - Specifies what should happen when receipts are created for purchase orders that are
unconfirmed in Receipt Entry or PO Receipt on the handheld.

You can select to allow, warn or stop employees when they create receipts for unapproved/unconfirmed purchase
orders:

e Allowed - When you create a receipt for an unapproved/unconfirmed purchase order or add receipt lines
for an unapproved/unconfirmed purchase order, the receipt and receipt lines are created successfully and no
warning messages display.

e Warn - When you create a receipt and select an unapproved/unconfirmed purchase order Receipt Entry in
the PO field, a warning message displays that the purchase order is unapproved/unconfirmed. Click OK to
continue the transaction.

When you add the first receipt line on a receipt in Receipt Entry and the purchase order is unconfirmed, a
warning message displays that the purchase order is unapproved/unconfirmed with a Yes or No option.

* Yes - You can continue the receipt line entry.

h Note The warning message only displays for the first line added to the receipt.

* No - The screen clears and the receipt line entry is cancelled.

Using Mass Receipts in Receipt Entry, when you click the Selected check box for an unapproved/unconfirmed
purchase order line in the PO Releases list, a warning message displays that the purchase order is
unapproved/unconfirmed with a Yes or No option.

* Yes - The line moves to the Mass Receipts list .

h Note The warning message only displays for the first line added to the receipt.

* No - The selection clears and the line does not move to the Mass Receipts list.

When you enter a PO and Pack in PO Receipt (handheld), a warning message displays that the purchase
order is unapproved/unconfirmed with a Yes or No option.

* Yes - You can continue the receipt.

* No - The screen clears and the receipt entry is cancelled.

e Stop - When you create a receipt in Receipt Entry or PO Receipt (handheld) and select an
unapproved/unconfirmed purchase order, an error message displays that the purchase order is
unapproved/unconfirmed. Click OK to continue. The receipt entry is cancelled and the screen is cleared.

Menu Path: System Setup > Company/Site Maintenance > Company Configuration
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Miscellaneous Shipment - RMA and DMR

A miscellaneous shipment Pack ID is automatically created as a result of selecting the Job or Return Shipment
options in the RMA Dispositions > Disposition > Detail > Dispose To field or via DMR Processing using the Return
To Customer functionality, given that you select the Misc Shipment from WIP check box located on the Job Entry
> Job > Make To Stock > Detail sheet.

The following rules apply to a miscellaneous shipment Pack ID if you select the Misc Shipment from WIP check
box:

¢ You cannot add new lines to the Pack ID.
¢ You cannot delete the Pack ID.
* You cannot reopen a closed job.

[ Note If the miscellaneous shipment has been changed to a status different than Open (Closed, Freight,
Staged, Shipped) you cannot reopen a closed job. If you reopen the closed job that carries the Open
status, the linked miscellaneous shipment Pack ID is automatically deleted. If the part carries serial
numbers, the serial numbers acquire the original status.

¢ You cannot delete lines from the Pack ID.
¢ You cannot void the Pack ID.

If the miscellaneous shipment has been changed to a status different than Open (Closed, Freight, Staged, Shipped)
you cannot reopen a closed job.

[ Note When you enter a Pack ID you can search for and select the relevant RMA number and line tied to
a customer record. The RMA/Line button is located on the Summary and Header sheets in both
Miscellaneous Shipment Entry and Miscellaneous Shipment Tracker.

[ Note If a part on a DMR record includes serial number(s) and you execute Return To Customer, the serial
number(s) move to the automatically created miscellaneous shipment Pack ID.

e Menu Path: Material Management > Shipping/Receiving > General Operations > Miscellaneous Shipment
Entry

* Menu Path: Material Management > Shipping/Receiving > General Operations > Miscellaneous Shipment
Tracker

RMA Disposition Entry - Return Shipment

The Dispose To field located on the RMA Disposition Entry > Disposition > Detail sheet includes the Return
Shipment option.

Select this option if the material should be returned to a customer. Selecting this option automatically creates a
Miscellaneous Shipment record and INS-SHP transaction type.

h Note Selecting this option inactivates the Request Move check box.

Menu Path: Sales Management > Order Management > General Operations > RMA Dispositions
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Use the Purchase Management module to create purchase orders and track supplier performance. Detailed line
items indicate planned receipts to inventory or a job, although their destination can be changed at the time of
actual receipt entry.

Purchase order receipt processing updates suggested supplier and detailed purchase history files, which provides
continual reference to aid in making purchasing decisions.

An online time-phased material requirements report provides a strategic planning tool to buy the right amount
of material - at the right time. With Purchase Management, you can reduce inventory levels, improve on-time
deliveries, enhance your cash flow, and increase your profit levels.

Supplier Price List - Part and Subcontract Operation Attachments

You can add attachments to a part or subcontract operation in Supplier Price List.

Employees need the ability to add attachments directly to a part or subcontract operation in Supplier Price List
so that users can view related information about the part or subcontract operation where needed.

To add an attachment to a part or subcontract operation in Supplier Price List, navigate to the Detail or List
sub-sheet of the Part or Subcontract Operation sheet and select the part or subcontract operation. Then click
the Attachments icon on the taskbar or select Add Attachment from the Actions menu. The Actions sheet
displays in a separate tab and you can add attachments as needed.

Menu Path: Material Management > Purchase Management > Setup > Supplier Price List

Tracker Transaction History Range

Use the Number of Days field in Company Configuration to set the default number of days of history to
retrieve when retrieving transactions in trackers. Use Actions > Transaction History Range in Supplier Tracker
to override the default number of days of transaction history to retrieve when retrieving transactions.

If your company has large amounts of transactional data, defining a transaction history range allows you to limit
the number of transactions you retrieve. In Supplier Tracker, you can define the number of days prior to the
current day to display when you retrieve transactions.

For example, if you select to view transaction history for 10 days, only transactions that have a date of today
minus 10 days are retrieved. Any transactions outside the range are not retrieved.

In Company Configuration, you can determine the default number of days to retrieve in all trackers.

In the Supplier Tracker, you can use the Transaction History Range action to override the default setting in
Company Configuration and set a specific history range filter for the Supplier Tracker.

The transaction history range filter affects transactions you retrieve by selecting Retrieve Transactions or Auto
Retrieve Transactions from the Actions menu. If also affects transactions you retrieve by navigating to the
Transaction sheet and clicking the Retrieve button.

This feature covers the following areas in Epicor ERP application:

e Company Configuration - A Number of Days field was added to the Modules > All Modules > General
sheet to define the default Number of Days when you retrieve transactions in trackers.

Menu Path: System Setup > Company > Site Maintenance > Company Configuration

e Supplier Tracker - A Transaction History Range window was added to the Actions menu to define the
history range when you retrieve transactions. The window has the following fields:

* Number of Days - Specifies the number of days before the current day to display when you retrieve
transactions in the tracker.
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W Note If the value in this field is 0, there are no date range restrictions when you retrieve transactions.

e Save Setting - If selected, the tracker uses this Number of Days value each time transactions are retrieved
in the Supplier Tracker

Menu Path: Material Management > Purchase Management > General Operations > Supplier Tracker

Generate Purchasing Suggestions - Logging Type

Process Generate Purchasing Suggestions includes the Logging Type field where you can specify a logging type
used during each PO Suggestions generation run.

Depending on the option you select in this field, the application will overwrite, add a date/time or content to log
files during each run. The field includes the following options:

e Append - Adds content at the end of the log files.
e Overwrite - Overwrites the log files during each run.

W Note This is a default option.

e Split - Adds a date and time in the filename to create separate log files for each run.

Menu Path: Material Management > Purchase Management > General Operations > Generate Suggestions

For the reporting and filing purposes, a Change Log is displayed on several programs and trackers.

Use the Changed By field to view the username of the person who last changed the selected record. The Change
Date field displays the date and time of the last change.

To access the change log, select Change Log from the Actions Menu.
A Change Log was added to the following programs and trackers:

e Bill of Lading Entry

e (Container Landed Cost Entry

e Container Landed Cost Tracker
e (Container Receipt Entry

e Customer Shipment Entry

e Customer Shipment Tracker

e Demand Contract Entry

e Demand Entry

e Drop Shipment Entry

e Drop Shipment Tracker

e Forecast Entry

e Master Pack Shipment Entry

e Miscellaneous Shipment Entry
e Miscellaneous Shipment Tracker
e Price List Maintenance

® Receipt Entry
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e Receipt Tracker

® Receive Transfer Order

® Requisition Entry

e Requisition Tracker

e RFQ Entry

e Service Call Center

e Subcontractor Shipment Entry

e Subcontractor Shipment Tracker
e Transfer Order Entry

e Transfer Order Shipment Entry

e Transfer Order Shipment Tracker

Epicor financial management solutions provide manufacturers with the tools needed to create value through
monitoring financial conditions and timely decision making.

This functionality reduces costs and improves cash flow. Epicor Financials can help improve your ability to drop
more to your bottom line—the ultimate test of your success and competitive advantage.

Use the Accounts Payable (AP) module to enter supplier invoices for purchases that you make and then create
checks, payment instruments, or generate bank electronic funds transfer (EFT) files for the invoices you want to
pay. Adjustments are created if the purchase price does not match the invoiced price.

The application can generate payments for all invoices due, those for a particular supplier, or only for specific
invoices. If a supplier calls you to discuss an invoice, you have complete information at your fingertips and that
history can be kept indefinitely. With Accounts Payable, you know how much you owe and when it is due.

You use the Accounts Payable functionality to update both purchase orders in Purchase Management, as well
as actual job costs.

Partial AP Deductible Tax Processing

When you set up a tax type in Tax Type Maintenance, the Default Tax Timing and Collection Method
controls define when and how taxes are accounted for and are posted as committed tax transactions. You can
also specify the deductible part of the tax when setting up the tax rate to use for the type. The AP Deductible
% value may be defined when the Collection Method you use is Invoicing and for all Default Tax Timing
options, such as on Invoice, on Partial Payment, and when the invoice is Fully Paid.

Financial Management > Accounts Payable > Setup > Tax Type

AP Invoice Entry

e When Default Tax Timing is set to Invoice, tax is split between tax accrual and non-deductible tax accounts
according to the AP Deductible % value.

e When Default Tax Timing is set to Partial Payment or Fully Paid, the non-deductible part is processed exactly
as when Default Tax Timing is set to Invoice; the deductible part is posted to the interim tax account.
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AP Payment Entry - Invoice Payment
e When Default Tax Timing is set to Invoice, tax is not calculated and not posted.

e When Default Tax Timing is set to Partial Payment or Fully Paid, interim tax is reversed.

AP Payment - Miscellaneous Payment

Non-deductible tax processing is the same for all Default Tax Timing options. When misc. payment is posted, the
non-deductible tax amount is calculated based on the AP Deductible % value and is posted separately to the
Non-deductible tax account, if that context is set, or to the current expense account.

Apply Debit Memo / Prepayment

e When Default Tax Timing is set to Invoice, tax is not calculated and not posted.

e When Default Tax Timing is set to Partial Payment or Fully Paid, interim tax is reversed.

AP Taxable Adjustment

Taxable adjustments are not allowed for invoices with payment timing taxes, withholding taxes, and non-deductible
taxes.

Void Payment Entry

Non-deductible tax processing is the same for all Default Tax Timing options. When payment is voided, all original
postings including taxes are reversed.

ACH Payments

Use the ACH Payments functionality to manage the settings for electronic payments made through the Automated
Clearing House (ACH) Network.

The ACH-specific options settings are available on the following sheets:

e Menu Path: Financial Management > Accounts Payable > Setup > Bank Account

* Menu Path: Financial Management > Accounts Payable > Setup > Supplier

e Menu Path: Financial Management > Accounts Payable > General Operations > Payment Entry

Automatic Matching of AP Payments

You can perform automatic matching of AP payments based on the invoice number, invoice legal number, and
banking reference number.

Matching based on banking reference number is applicable for the following countries:
* Belgium

e Denmark

e Estonia

e Finland

e Norway

e Sweden

e Switzerland

Menu Path: Financial Management > Accounts Payable > General Operations > Bank Statement Processing

10.2.300



10.2.300 Feature Highlights 10.2.300 Feature Highlights

Withholding Tax Payment Report

The Withholding Tax Payment Report program enables you to determine how much you will pay for corporate
and non-corporate tax types, and to mark all the withholding taxes paid for invoices selected in the previous
periods as paid.

Menu Path: Financial Management > Accounts Payable > Reports > Withholding Tax Payment Report

Withholding Tax Payment Export
The Withholding Tax Payment Export program enables you to export a Withholding Tax Payment Report in
different formats.

Before you generate a data file, you select an electronic interface for a required format. The data file is generated
to the specified path and is also attached to the report entry.

Menu Path: Financial Management > Accounts Payable > Reports > Withholding Tax Payment Export

Use the Accounts Receivable (AR) module to bill your customers as orders are shipped and then track payments
as they are received.

Since you can specify the creation of invoices through the order release process, it is possible to reduce billing
for a different quantity than for what was actually shipped.

Customer invoices may be previewed, printed on laser or continuous preprinted forms, faxed or emailed directly
to your customer. With Accounts Receivable, you know who is buying what, and who is paying their bills on
time.

ACH Payments

Use the ACH Payments functionality to manage the settings for electronic payments made through the Automated
Clearing House (ACH) Network.

The ACH-specific options settings are available on the following sheets:

e Menu Path: Financial Management > Accounts Receivable > Setup > Bank Account

e Menu Path: Financial Management > Accounts Receivable > Setup > Customer

e Menu Path: Financial Management > Accounts Receivable > General Operations > Cash Receipt Entry

Automatic Matching of AR Payments

You can perform automatic matching of AR payments based on reminder letter number and banking reference
number.

Matching based on banking reference number is applicable for the following countries:
e Belgium

e Denmark

e Estonia

e Finland

¢ Norway

e Sweden
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e Switzerland

Menu Path: Financial Management > Accounts Receivable > General Operations > Bank Statement Processing

Auto Creation of Invoice Cash Receipts

You can automatically generate a cash receipt with allocated invoice based on reminder letter number and
banking reference number.

Auto creation of invoice cash receipts based on banking reference number is applicable for the following countries:
® Belgium

e Denmark

e Estonia

e Finland

¢ Norway

e Sweden

e Switzerland

Menu Path: Financial Management > Accounts Receivable > General Operations > Bank Statement Processing

Withholding Tax Payment Report

The Withholding Tax Payment Report program enables you to determine how much you will pay for corporate
and non-corporate tax types, and to mark all the withholding taxes paid for invoices selected in the previous
periods as paid.

Menu Path: Financial Management > Accounts Receivable > Reports > Withholding Tax Payment Report

Withholding Tax Payment Export
The Withholding Tax Payment Export program enables you to export a Withholding Tax Payment Report in
different formats.

Before you generate a data file, you select an electronic interface for a required format. The data file is generated
to the specified path and is also attached to the report entry.

Menu Path: Financial Management > Accounts Receivable > Reports > Withholding Tax Payment Export

Use the Payroll functionality to handle the processing of all employee paychecks and provide necessary company
and governmental reporting.

Leverage the comprehensive employee information and memo fields to track employee personnel information
like performance reviews and outside training.

As payroll is integrated with Job Management and Data Collection, you normally only have to review your payroll
entries, make adjustments, print your checks, and then post the resulting records. If you use the Payroll module,
you no longer need to have your payroll done through an outside service, as you can now easily run payroll
internally.

Payroll Electronic Deposits NACHA Bank Interface

ERP Payroll module allows you to export payroll data in files and send them to a bank as order to make transfer
of payroll payments to employees. An output file can be standard simple text format or NACHA format. Standard
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simple text output file does not represent interface directly used by banks, usually additional reformatting outside
ERP system is required to transform it to a file acceptable by a particular bank.

Opposite, a NACHA format file can be sent directly to a bunch of banks. A NACHA file is used to execute domestic
ACH payments through the Automated Clearing House Network. It is a payment instruction file that gets sent
or uploaded to a bank portal in order to execute a mass payment batch. NACHA files require unique formatting
with particular specifications. While the details of the file format can vary slightly between different financial
institutions or banks, there are a number of Standard Entry Class Codes (SEC codes) that relate to ACH payment
files.

The new functionality covers the following areas of the Epicor ERP application:

e Electronic Interface Maintenance - The Electronic Interface Maintenance program was added to the Payroll
> Setup Programs to create, setup or modify electronic interfaces from the Payroll module.

Menu Path: Financial Management > Accounts Receivable > Setup > Electronic Interface
Menu Path: Financial Management > Accounts Payable > Setup > Electronic Interface

Menu Path: Financial Management > Payroll > Setup > Electronic Interface

e Bank Account Maintenance and Bank Account Tracker - The Electronic Interface and Payroll Entry
Class Code fields were added to the Payroll sheet in the Bank Account Maintenance and Bank Account
Tracker programs to specify an electronic interface to be used when processing a Payroll Group, and a Payroll
Entry Class Code used when processing the electronic interface for direct deposit check deductions.

Menu Path: Financial Management > Account Receivable > Setup > Bank Account

Menu Path: Financial Management > Accounts Payable > Setup > Bank Account

Menu Path: Financial Management > Cash Management > Setup Bank Account

Menu Path: Financial Management > Payroll > Setup > Bank Account

Menu Path: Financial Management > Accounts Payable > General Operations > Bank Account Tracker
Menu Path: Financial Management > Cash Management > General Operations > Bank Account Tracker

Menu Path: Executive Analysis > Trackers > Bank Account Tracker

e Payroll Check Entry
Menu Path: Financial Management > Cash Management > General Operations > Payroll Check Entry

Menu Path: Financial Management > Payroll > General Operations > Payroll Check Entry

The External Payroll Integration module enables you to configure external payroll setup in order to create files to
export to an external payroll provider. The programs under Setup in this module enable you to create payroll
employees, pay types and classes, holidays, and configuration of the export file that will be sent to the external
provider. The External Payroll Processing program, under General Operations, enables you to create the payroll
file to send to the external payroll provider.

In order to use the External Payroll Integration module, the External Payroll license must be installed.

[ Note You also have to set up and activate the external payroll configuration in Company Configuration,
on the Modules > Finance > Payroll Integration sheet.
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Column Title in Export File - Layout Configuration

Use the Column Title column of the Payroll Export Configuration Fields grid to specify the source field header
to display in the export file.

[ Note Headers are included in export files only when the Suppress File Header check box is clear in
Company Configuration > Modules > Finance > Payroll Integration.

Menu Path: Financial Management > External Payroll Integration > Setup > Export File Layout Configuration

Overtime Per Day Threshold Calculation for All Employees

Use the Apply Per Day Threshold's to All Frequencies check box in External Payroll Class Maintenance
to determine if Overtime Per Day and Double Time Per Day thresholds will be applied to all employees in the
payroll process.

If this check box is clear, only weekly or biweekly paid employees will get this pay.

Menu Path: Financial Management > External Payroll Integration > Setup > External Payroll Class Maintenance

General Ledger (GL) processes and posts entries created by Job Management, AR, AP and Payroll, as well as
manual entries made directly in the general ledger.

A chart of accounts is easily established to control how you want the application to report on your business. You
can even export your general ledger data to a spreadsheet to handle any special requirements. When you set up
legal numbers for transactions, the sequences can be assigned by user IDs and warehouses.

General Ledger Report For Single Account
You can now use the General Ledger Report to display financial information for a single account. This may be
useful for reviewing and reconciling journal details for control accounts which typically receive a lot of movement.

To select a single account, use the Account option on the General Ledger Report form and specify the GL
Account for which you want to run the report.

Menu Path: Financial Management > General Ledger > Reports > General Ledger

Posting Rules Check Syntax Functionality

Use the Check Syntax button on GL Transaction Type Maintenance > Revisions > Detail sheet, GL Transaction
Type Maintenance > Revisions > Book > Functions Detail sheet, GL Transaction Type Maintenance > Revisions >
Book > Booking Rules > Operations Base and Customization sheets to validate check of the selected
revision/rule/function for compilation errors.

If the application detects an error, the revision/rule/function will be marked in the navigation tree, and the
operation causing this error will be highlighted. You can hover your mouse over the highlighted operation to
view the tip for the error.

Quick Posting Rules Navigation
Within the GL Transaction Type Maintenance program, you can quickly navigate from the current posting rule

or function to user-defined function definition by clicking the Go to Function Definition selection from the
Context menu. A rule or function operation that calls a user-defined function is marked with a specific icon. You
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can go back to the posting rule or function by clicking the related link displayed on the user-defined function's
operation tab.

Improve your cash management processing cycle through the automatic handling and reporting of discounts
available, payment due dates and payment selection methods.

Cash Management includes setup programs used to define bank accounts and bank fees associated with cash
receipts, cash payments, bank statements, and bank adjustments. The setup programs also prepare you to import
payment files and to make electronic payments.

You can also use the Cash Management module to manage the company's general ledger cash accounts, as well
as to reconcile a bank balance with cash balances in the company's books.

With an additional license from Epicor, you can use the Petty Cash functionality to create petty cash document
forms in compliance with the requirements needed by many government organizations. Key features are in place
to support legal requirements for legal numbering, document forms, and daily balances and reports.

Print Remittance Slips
Use the Print Remittance Slips command to print out remittance slips for all current payments excluding deposit
slips. You can select customers or payments in the Filter tab.
This command is available using the Actions menu in the following programs:
e (Cash Receipt Entry
Menu Path: Financial Management > Accounts Receivable > General Operations > Cash Receipt Entry
e (Cash Receipt Tracker
Menu Path: Financial Management > Accounts Receivable > General Operations > Cash Receipt Tracker
e Bank Receipt File Import

Menu Path: Financial Management > Accounts Receivable > General Operations > Bank Receipt File Import

Quoting and managing sales orders enables the vital coordination of activities between your sales, site, shipping,
and accounting groups.

You dictate whether to hold all companies in a single database, or each company in individual databases, where
each company can have its own chart(s), currencies, and calendars.

Use the Quote Management and Order Management modules to capture orders and seamlessly integrate the
information with supply chain, production, fulfillment, and accounting systems.

By streamlining the sales process—centralizing access to product, pricing, customer information - orders can be
generated with a minimal number of steps. It automates and improves labor-intensive processes for quoting,
proposal generation, configuration, and order entry. You can increase sales productivity by ensuring accuracy
during the quote and order processes and identifying the right solution to meet your customers’ needs.

[ Important If your Customer Relationship Management (CRM) license is installed and functional, the Epicor
application displays an alternate Main Menu than the one shown without CRM. With the CRM license,
the Sales Management module is referred to as Customer Relationship Management.
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Dealer Portal

In 10.2.300, a modern integrated Dealer Portal experience will be available for manufacturers that sell and service
through a Dealer Network.

For the manufacturer, this solution allows you to:

¢ Simplify processing with a single portal to configure and price products and quote customers.
¢ Integrate and accelerate processes.

e Gain insights into end buyer behavior.

e Improve dealer ramp, recruitment, and retention.

For your dealers, this solution provides:

e One-click process makes buying easy.

e Errors reduction.

¢ Productivity increase.

e Encourage loyalty.

Dealer Portal offers a branded experience for two job roles at the dealer to interact with the manufacturer:
A sales person at a dealer can:

¢ Configure and price products.

e C(Create, review, and update quotes.
e Convert quotes to sales orders.

e Convert sales orders to build.

A service person at a dealer can:

e Review quotes and sales orders.

e Search inventory.

e Manage returns.

e Order spare parts.

e Manage customer warranty.

e Place service requests to manufacturers.

i Note Dealer Portal can be used by manufacturers of any product sold and serviced through a dealer
network.

General business flows include:

The Dealer Network License covers the following areas of the Epicor ERP application:

e AR Invoice Entry
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e (ase Entry

¢ Configurator

e Customer Entry

e Customer Shipment Entry

e Dynamic Attribute Class

e |ID Number Assignments

¢ |D Numbers Maintenance

e Job Entry

e Location Ownership Transfer

e Opportunity/Quote Entry - Used for pre and post sales
e Part Maintenance

e Replacement Part Entry

e Sales Order Entry - Used for pre and post sales
¢ Site Configuration Control

Dealer Portal leverages the power of Epicor Commerce Connect (ECC) to bring a modern commerce experience
to manufacturers. It is available as a separate product license. Please consult your Account Manager for further
details.

v Example A manufacturing company has a dealer network in which customers can purchase inventory
direct from the dealer or place a custom order. The manufacturer needs to track ownership and warranty
status as well as for dealers to track and transfer inventory between dealers.

Configure Service Dealer
item request View

e Sales
1. End customer visit Dealer Showroom.
2. Dealer logs in to store.

3. Customer and Dealer walk through configuring an item.

¢ Configure Item
1. Select a model.
2. Choose options.

3. Dealer creates quote.

e Order
1. Customer accepts quote.
2. Dealer places order.

3. Order submitted to Manufacturing.
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¢ Fulfillment
1. Dealer receives the item.
2. Dealer registers customer buyer.

3. Dealer sets up customer warranty.

e Service Request
1. Customer visits dealer for service request.
2. Dealer handles customer service request.
3. Dealer works with manufacturer for warranty repair work.

4. Dealer orders spare parts.

e Dealer View
1. Dealer can view inventory.

2. Exchange inventory with other dealers.

The Order Management module virtually drives the Enterprise Resource Planning (ERP) system. From the time
you place an order, its progress is tracked through final shipment while producing timely reports on demand.

With Order Management, all orders and change orders are effectively managed online, reducing the chance for
error and smoothing out the order-to-delivery process for maximum customer satisfaction.

Credit Card Processing - CRE Test Mode

The Test Mode provides a simple method for testing your Epicor Cloud Retail Environment (CRE) setup for
processing credit card transactions. You can test credit card configuration before actually using it against your
actual data.

To implement the test mode feature, the following programs were enhanced:

Credit Card Configuration

Use the Test Mode check box in the Credit Card Configuration program to activate test mode in the CRE gateway.
For testing purposes, you can only use test processors that end with test, for example, paypal_pfnvp_test.

To generate CRE logs, select the Enable Logs check box.

Menu Path: Sales Management > Order Management > Setup > Credit Card Configuration

Sales Order Entry

When the Testing Mode is active, the Sales Order Entry program displays the Credit Card is on Test Mode
warning message on saving credit sales orders.

Menu Path: Sales Management > Order Management > General Operations > Order Entry
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Cash Receipt Entry

When the Testing Mode is enabled, the Credit Card is on Test Mode warning message displays in the Cash
Receipt Entry program on saving cash receipts.

Menu Path: Financial Management > Accounts Receivable > General Operations > Cash Receipt Entry

Token Migration and Mass Void Authorizations

Use the Enable Logs check box to generate CRE logs. All calls made by the user interface to the server now
automatically record within the log. If this check box is selected, it means that the tracing log is active.

Menu Path: System Management > Rebuild Processes > Finance > Token Migration and Void Authorizations

Credit Card Processing - Multi Currency

The multi currency solution allows you to process and settle transactions in local currencies via the Epicor Cloud
Retail Environment (CRE) gateway. This enhancement supports your expansion into foreign markets in a cost
effective manner.

h Note This feature is only available if the Multi Currency license is installed.

To implement this feature, the following changes were made:

Credit Card Configuration
The Credit Card Configuration program is modified to include the following sheets:

e Configuration - Use this sheet to specify the parameters your company will use to connect to the Gateway.

e Processor - Use this sheet to enter credit card processors for each currency defined in the Currency Master
Maintenance program and select a different bank account for each processor. A grid list enables you to review
the list of all available processors.

You can only process credit card transactions in a currency other than the base currency if your credit card
configuration uses the Epicor Cloud Retail Environment (CRE) gateway. Make sure the selected processor supports
this currency; otherwise, this may result in incorrect credit charges. Additionally, if you are changing the CRE
gateway to the Secure Data Manager (SDM) gateway, you need to remove the processors assigned to each
foreign currency manually.

Currency Master Maintenance

Use the Processor field in the Currency Master Maintenance program to specify the credit card processor for
each specific currency. All credit card transactions generated for this currency in Sales Order Entry or Cash
Receipt Entry use the selected processor. Ensure to define the payment processor to be able to select the Credit
Card check box in Sales Order Entry and Cash Receipt Entry.

Company Configuration

To enable users to define a different bank account for each payment processor used for credit card payments,
the Default Bank field on the Modules > Sales> Order sheet is duplicated on the Processors sheet in the
Credit Card Configuration program under the Bank Account name. The Default Bank field is moved from the
Credit Card Processing group box to the adjacent group box in Company Configuration, as it is used in other
projects, not related to credit card.

Credit Card Transactions Report

The Credit Card Transactions report includes the Currency Code column used to identify the currency for credit
card transactions.
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Token Migration and Void Authorizations

The Target Partner Information group box is removed from the Token Migration and Void Authorizations
program, as the target payment processor is linked to the currency of each credit transaction and is currently
defined in the Currency Master Maintenance program.

Order Entry - Clear Credit Card Order Check Box

Clear the Credit Card Order check box in Order Entry if the order should not be charged to a credit card.

Order Entry personnel need the ability to remove the Credit Card Order flag if a customer will no longer be using
a credit card to pay for an order. For example, they may have failed their credit card authorization.

In Order Entry, you can clear the Credit Card Order check box in the Header > Credit Card sheet if there are
no more open credit card authorizations pending for the order, they were voided or rejected, or if all Deposit/Sale
transactions were successfully submitted for this order.

If an order has multiple authorizations, and at least one authorization has not been settled, you need to void
each open authorization manually to be able to clear this check box.

Menu Path: Sales Management > Order Management > General Operations > Order Entry

Order Entry - Multi-Level Capable to Promise (CTP) for Kits

Use Capable to Promise (CTP) in Order Entry to perform multi-level CTP on manufactured parts within a kit.

Order Entry personnel need the ability to perform multi level capable to promise activities on kits in Order Entry
so that multiple levels in a kit are considered when calculating CTP dates. You can also use CTP processing to
initiate jobs to fulfill manufactured kit components.

If the Multi Level CTP check box is selected for a manufactured kit component in the Part > Sites > Detail
sheet in Part Maintenance and the Available to Promise information indicates that there will not be sufficient
guantity on hand to meet the requested date, an unfirm job is generated and scheduled to determine when
quantity for the kit component could be available. If the Multi Level CTP check box for the kit component is
clear, no job is generated, and Capability to Promise uses the manufacturing lead time for the part to determine
when quantity could be available for the component.

[ Note You can only select the Multi Level CTP check box for parts with a type of Manufactured, not for
the kit itself.

When you click Confirm in the Capable to Promise window for a kit, the CTP performs the following processes
when it determines that there is not enough supply of a manufactured kit component to fulfill the kit on the
order release.

1. If the Multi Level CTP check box for the kit component is selected, there is insufficient stock available and
the kit component quantity needs to be manufactured, the following processing takes place when you click
the Confirm button, based on the setting of the Make To Stock field in the Site Configuration Control
> Modules > Inventory > General > Detail sheet:

¢ If set to Create Firm Job, a firm Make to Stock CTP job is created for the outstanding unfilled amount
(for the difference between the ordered quantity and the amount available for fulfilling the demand).
The Completion Date is set as the date that the Scheduling engine calculates for the number of pieces
being manufactured.

¢ If set to Create Unfirm Job, an unfirm Make to Stock CTP job is created for the outstanding unfilled
amount (for the difference between the ordered quantity and the amount available for fulfilling the
demand). The Completion Date is set as the date that the Scheduling engine calculates for the number
of pieces being manufactured.

¢ If set to No Job, no job is created.
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[ Note When jobs are created for kit components through the CTP process, a job is created for each
manufactured kit component that has the Multi Level CTP check box selected and has insufficient
supply to fulfill the order. For example, if a kit contains three manufactured items that have the Multi
Level CTP check box selected and do not have sufficient supply, the CTP process creates three jobs,
one for each kit component that must be manufactured to complete the kit and fulfill the order.

2. [Ifinsufficient stock is available and the part quantity needs to be manufactured, the Multi Level CTP check
box is cleared, a job is not created; the part Manufacturing Lead Time and Receive Time settings are
used to determine the day that it can be available.

Sales Kits Details

Use the Sales Kits Details context menu option in the Capable to Promise window to display CTP details for
each kit component. To access Sales Kits Details from the Capable to Promise window, right-click the Source
column of the kit in the Order Lines grid and click Open With > Sales Kits Details.

Use the arrows beside the Kit Component Line field to navigate through the different component lines in the
kit. The Kit Component Details pane displays CTP details for the kit component such as the source for the CTP
and the calculated completion date for the component. If an error occurs during the CTP process, the error text
also displays.

Menu Path: Sales Management > Order Management > General Operations > Order Entry

The Configurator process allows for on-the-fly configuration of highly customizable and dimensional products.
You can configure products through a straightforward question and answer evaluation or by Smart Strings entries
(intelligent part numbers) that identify a particular item configuration.

You can launch a Configurator page from within Opportunity/Quote Entry, Order Entry, Job Entry, Purchase
Order Entry, Demand Entry or the Epicor Commerce Connect Web Basket. This application is web-enabled,
and is also available to disconnected users employing Mobile Connect.

The configuration process is centered around the Configurator Designer. This single program is used to fully
set up the required configuration, including method rules, document rules, pricing rules, part creation, dynamic
lists, and so on.

Configurator Designer functions are divided among the following entry programs:
e Configurator Entry

e Configurator Designer

e Configurator Rule Entry

There are two main reasons for dividing the Configurator Designer into three different programs:

e Performance - Having fewer functionality panels in three single entry programs improves the performance.

e Ease of Use - With three different entry programs, you can go directly to the functionality you require. For
instance, splitting off Configurator Entry and Configurator Rule Entry provides you with more space to set
up the configurator functions and less sheets to navigate through. It also allows you to have a different user
interface (Ul) concept, with most functions included in the Property section of the Configurator Designer.
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Image Layering Entry

Use Image Layering Entry to define image layer definitions (transparent images). Image layer definitions are
used by the Configurator Designer to know which layers are applied during a configuration session, so the
input displays in the same way as it did when originally configured and a desired image outcome is achieved.

The following rules apply:

e You can tie each base image to multiple transparent images (Image Layer IDs).

e Transparent images being used for the base image must be of the same size. Improperly defined image layers
result in an inaccurate final image.

e You must create one transparent image for each permutation of options.

u Example If the item being processed includes ten options and each option includes twenty five color
possibilities then you must provide the base picture and two hundred and fifty transparent images for
each of the options.

e You are fully responsible for managing images and must ensure that all the urls are valid and the images
exist in the specified location. You must also maintain urls. The images are stored either in a content delivery
network (CDN) or a file system.

* When you add an image layer definition in Configurator Designer using the Layered Image input (Toolbox),
you can manually type the required Image Layer ID in the Input Properties pane to validate the base image
found in the directory specified on the image layer header in Image Layering Entry. You can also search
for and select the required Image Layer ID by using the ellipse button located on the Configurator Designer
> Input Properties > Behavior > Image Layer ID line.

h Note You can only enter and save approved Image Layer IDs.

e Image layering is not supported by Epicor Web Access (EWA).

® You can use the Where Used actions command to generate a list of configurators that a specific Image Layer
record is used on.

[ Example If you modify an image layer definition using Image Layering Entry, for example, add another
image layer detail, and the image layer ID is tied to three different configurators, use the Where Used
functionality to review a list of configurator records as well as select the ones that you want to tie to
this modification.

M Important You can only select configurators with an unapproved status.

[ Note Once you select the required configurator(s) and apply the modification made to an image layer
record, execute the Where Used > Actions > Rebuild Configuration Image Layer Details command.

e Use the Configurator Designer > Actions > Refresh Input Image Layer Details to refresh Layered Image
input(s) located on your page.

[ Example If you modify two image layer definitions using Image Layering Entry - for example add
another image layer detail - and the image layer IDs are tied to two different Layered Image inputs on
the same configurator, use Refresh Input Image Layer Details to review a list of Layered Image inputs
and only select/update the ones that you want this modification to apply to.

M Important To execute Refresh Input Image Layer Details, you must first unapprove the configurator.
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# . Important If you modify an Image Layer ID record defined in Image Layering Entry and the Image Layer

u ID is used on a configurator (Layered Image Input) that was already used, for instance, on a quote or sales
order, a notification message is automatically generated in a log created by the Verify Existing
Configurations process. The log informs you about the change in versions, since you have made a
modification to the Image Layer ID record that was previously used during the configuration process.

8 Important If the configurator page includes the Layered Image input control, you cannot deploy the

u configurator to Epicor Web Access (EWA).

[ Note If a configurator that you are importing via Configurator Entry includes a Layered Image input, it
will import only if a valid Image Layer ID exists. If it does not, the Layered Image input won't import and
you will be notified by a message. Therefore, the imported configurator won't include the Layered Image.

[ Note The Image Layering Entry program is only available if you install the Epicor Configurator 10.2.300
license.

Menu Path: Sales Management > Configurator Management > Setup > Image Layering

Picture Box - Input Rules

The Configurator Designer > Design > Page Designer > Input Properties pane includes the Input Rules
option used to launch Input Rules Maintenance, where you define input rules that automatically change the value
of an input based upon the value entered in another input without having to write C-Sharp (C#) code.

Business Scenario

Based on the option selected in a Combo Box input you want to automatically change an image included on a
Configurator Page without defining an Input On Field Validating event .

[ Example A configurator page includes a Combo Box input with three different options. The page also
includes a Picture Box input. When you select an option in the Combo Box input, the Picture Box
automatically refreshes with the images that are mapped to the selected option.

The following rules apply to the Input Rules defined for the Picture Box input control:
¢ In a multi-company environment, a Picture Box input control with defined Input Rules in a Manufacturing
Company is moved to a Sales Company using the Enterprise Configurator Direct Server Process.

e Using the Part Maintenance > Actions > Duplicate command, if you duplicate a part that carries a
configurator and the configurator includes a Picture Box input control with defined Input Rules, the Picture
Box/Input Rules are copied to the new part/configurator.

e Using the Configurator Entry > Actions > Duplicate Configuration command, if you duplicate a
configurator that carries a Picture Box input control with defined Input Rules, the Picture Box/Input Rules are
copied to the new configurator.

* You cannot delete the Picture Box input if it is tied to an input rule.
e Input Rules for Picture Box is available to all who currently hold the Product Configurator license.

Menu Path: Sales Management > Configurator Management > General Operations > Configurator Designer

Epicor Web Configurator

You can mark configurators as Epicor Web Configurator (EWC) and deploy them to Epicor Web.

When you enter a configurator record and set it to EWC, all Client processing is moved to the web and the
existing Server side logic remains in the Epicor ERP application. For example, if you launch the EWC configurator
from within a sales order, you open an iFrame and hand off control to the EWC team. The EWC team will deal
with any Client side events and make the appropriate calls to the server for Keep When rules, part swaps, and
Server side User Defined (UD)/Lookup Methods. When all is complete, they will call into the Configuration Runtime
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service method to save the configuration. The EWC configurators have the ability to apply CSS so your configurators
include a more modern look.

Setting configurators to EWC enables you to use the TypeScript open source programming language that supports
the Kinetic technology used by EWC configurators. You enter TypeScript expressions in the Code Editor as well
Configurator User Defined Methods Maintenance that includes the TypeScript sheet. Use the sheet to create
an expression for a desired user defined method.

In this release, Epicor Web Configurator will support a limited set of Ul features. More Ul features will be made
available in subsequent releases.

h Note You can also enter TypeScript expressions for Dynamic Lists (Configurator Designer).
h Note To use Epicor Web configurators you must install the Epicor Configurator 10.2.300 license.

Menu Path: Sales Management > Configurator Management > General Operations > Configurator User Defined
Method Maintenance

Allow Recycling of MRP Jobs

You can recycle jobs that include configurable parts.

The Configurator Entry > Detail sheet includes the Allow Recycling of MRP Jobs check box that controls whether
Process MRP should recycle jobs that include configurations.

[ Note You cannot recycle all the jobs that carry configurations error free. For example, only select this
check box for configurations that are good candidates for recycling. The good candidates include:

¢ Configurations that don't include Method and Document rules.
e If configurations include Method rules and the Method rules only use Input Values.

[ Note Try to avoid selecting this check box for configurations with Method rules that use outside data to
control important values in Bill of Materials (BOM). The outside data is anything that is not an Input Value
or logic User Defined Function related. For example, if the User Defined Function uses outside data to
calculate a return value that impacts the BOM then the application does not track it and therefore the
configuration would not be a good candidate for recycling.

Customer Relationship Management (CRM) is equipped with the tools you need to find more prospects and
quickly convert them to satisfied customers. Your sales people can manage the complete prospect-to-customer
life cycle, give accurate revenue forecasts to management and automate many administrative tasks.

With CRM you can manage and analyze the effectiveness of marketing campaigns and events. Marketers can
pinpoint targets, capture highly qualified leads, and perform cost/benefit and return on investment (ROI) analyses
on promotional activities. The campaign manager can track the number of leads, opportunities, orders, and costs
per campaign. Once you have the lead, the CRM functionality helps manage the entire sales process more
effectively, with features such as workflow and forecasting.

B, Important If your Customer Relationship Management (CRM) license is installed, the Epicor application
displays an alternate Main Menu than the one shown without CRM. With the CRM license, the functionalities
that correspond to the Customer Relationship Management folder are found under the Sales and
Marketing Management folder.
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Contacts can be shared across the Epicor application. For example, a payroll employee can now be added as an
authorized user for a buyer records reducing time and ensuring consistency You can share contacts between the
following records:

e shop employees (Shop Employee Maintenance)

e payroll employees (Payroll Employee Maintenance)
e workforce people (Workforce Maintenance)

e buyers (Buyer Maintenance)

e supplier contacts (Supplier Maintenance)

® purchase point contacts (Supplier Maintenance)

e customer contacts (Customer Maintenance)

Tracker Transaction History Range

Use the Number of Days field in Company Configuration to set the default number of days of history to
retrieve when retrieving transactions in trackers. Use Actions > Transaction History Range in Customer
Tracker to override the default number of days of transaction history to retrieve when retrieving transactions.

If your company has large amounts of transactional data, defining a transaction history range allows you to limit
the number of transactions you retrieve. In Customer Tracker, you can define the number of days prior to the
current day to display when you retrieve transactions.

For example, if you select to view transaction history for 10 days, only transactions that have a date of today
minus 10 days are retrieved. Any transactions outside the range are not retrieved.

In Company Configuration, you can determine the default number of days to retrieve in all trackers.

In the Customer Tracker, you can use the Transaction History Range action to override the default setting
in Company Configuration and set a specific history range filter for the Customer Tracker.

The transaction history range filter affects transactions you retrieve by selecting Retrieve Transactions or Auto
Retrieve Transactions from the Actions menu. It also affects transactions you retrieve by navigating to the
Transaction sheet and clicking the Retrieve button.

This feature covers the following areas in Epicor ERP application:

e Company Configuration - A Number of Days field was added to the Modules > All Modules > General
sheet to define the default Number of Days when you retrieve transactions in trackers.

Menu Path: System Setup > Company > Site Maintenance > Company Configuration

e Customer Tracker - A Transaction History Range window was added to the Actions menu to define the
history range when you retrieve transactions. The window has the following fields:

* Number of Days - Specifies the number of days before the current day to display when you retrieve
transactions in the tracker.

h Note If the value in this field is 0, there are no date range restrictions when you retrieve transactions.

e Save Setting - If selected, the tracker uses this Number of Days value each time transactions are retrieved
in the Customer Tracker

Menu Path: Material Management > Purchase Management > General Operations > Customer Tracker
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The Epicor suite of production management applications, comprised of Job Management, Scheduling, Material
Requirements Planning, and Quality Assurance, uses sophisticated technologies to model your best practices and
empowers your personnel to make decisions that result in optimization of your production process.

Whether you are a global, multi-site enterprise or a single-site manufacturer, the fundamental need for precise
and flexible planning and scheduling is an ever present requirement for your business. Specific functionality like
consolidated purchasing, transfer functionality, and consolidated financials helps global enterprises manage the
complexity of their size and take advantage of the efficiencies that smaller organizations enjoy.

MES Menu Security

When you define access for security roles in Handheld / MES Menu Security Maintenance, those settings
impact what programs an employee can access in the MES Menu. You can use the MES Menu Security Report
to display the menu items and/or employees associated with employee roles and PCID options.

System administrators need to be able to customize security for MES menu items based on employee roles.
MES Menu Security functionality covers the following areas of the Epicor application:

e MES Menu - Employees have access to options based on the security roles assigned to the employee in
Employee Maintenance and the employee roles selected for different menu items in Handheld / MES
Security Maintenance. If a menu item has an employee role selected in Handheld / MES Security
Maintenance, all employees that have the employee role selected in Employee Maintenance have access
to the menu item. All employees that do not have the check box selected in Employee Maintenance do
not have access to the menu item.

[ Example Daniel Lahey is selected as a shop supervisor in Employee Maintenance. Joan Davis is not
selected as a shop supervisor in Employee Maintenance. In Handheld / MES Menu Security
Maintenance, only shop supervisors have access to the Return Salvage Request program. David
Martin has access to the Return Salvage Request and Juan Miranda does not have access to the
Return Salvage Request program.

For programs that appear on more than one panel in the MES menu, if an employee role has access to the
program, employees with the employee role have access to the program on all panels where it appears.

[ Note Count Entry appears on the MES Menu on both the Production and Material panels. In
Handheld / MES Security Maintenance, Production Worker and Material Handler employee roles
have access to the program. Joseph Graciano is a production worker but is not a material handler.
When he logs onto the MES Menu, the Count Entry button is enabled on both the Production and
Material panels.

[ Note If no security role is selected for a menu or menu item in Handheld / MES Security Maintenance,
NO users have access to that menu or menu item.

e MES Menu Security Report - Displays the menu items and/or employees associated with employee roles
and PCID options. You can select to include employees and/or menu items associated with selected employee
roles and PCID options. By default, all employee roles and package control options are selected.
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Employee roles and package control options are selected for employees in Employee Maintenance. Employee
roles and package control options are selected for menu items in Handheld / MES Menu Security
Maintenance. You can filter the report by the employee or by menu ID.

[ Note If no employee role or package control option is selected, you receive an error message when
you try to run the report.

Menu Path: System Setup > Security Maintenance > MES Menu Security Report

Job Management is a comprehensive manufacturing control solution, designed specifically for the routing,
scheduling, costing, and tracking of either custom or repetitive parts manufactured on the shop floor.

Job Entry for a repeat part takes minimal effort. Analysis tools provide the quick and accurate reference necessary
for re-quoting a part or identifying the types of work at which your company is most profitable.

Return Goods Repair

Job Entry includes the Return Goods Repair pane used to specify that a job needs to be shipped directly from
WIP through Miscellaneous Shipment Entry when you close the job. The Return Goods Repair pane is located
on the Job Entry > Job > Make To Stock > Detail sheet.

The pane includes the RMA Line, RMA Number, DMR Number, DMR Action Number fields used to review
if a job is tied to an RMA or DMR records via the RMA Disposition Entry and DMR Processing programs. The
fields are for display only.

The pane also includes the Misc Shipment from WIP check box. Depending on whether you select the check
box, you can synchronize a job with an RMA Disposition or DMR Number.

The following rules apply if you select the Misc Shipment from WIP check box:

* The Epicor ERP application automatically creates a Miscellaneous Shipment Pack ID with RMA Disposition
information upon job closing or DMR information upon using the Return To Customer functionality.

[ Note The Ship To, Part Number, and Quantity are retrieved from the linked RMA Disposition or DMR
records.

e If the miscellaneous shipment has been changed to a status different than Open (Closed, Freight, Staged,
Shipped) you cannot reopen a closed job. If you reopen the closed job that carries the Open status, the linked
miscellaneous shipment Pack ID is automatically deleted. If the part carries serial numbers, the serial numbers
acquire the original status.

e |f you don't link an RMA Disposition or DMR records, information is retrieved from job's demand link (Make
to Stock) upon job closing.

[ Note The Ship To is the job number and Part Number with the required quantity is retrieved from job's
demand link.

e Youwon't be able to receive completed items to inventory or job. The Miscellaneous Shipment is automatically
created upon job closing.

* You can add a Make to Stock demand link for parts on the fly and select the Misc Shipment from WIP check
box.

¢ In RMA Disposition Entry, if you attempt to dispose of items using the Job option, the RMA/Line fields located
on the Job Entry > Job > Make To Stock > Detail sheet automatically update.

* In DMR Processing, if you add Return To Customer on a DMR record, the DMR/Action fields located on the
Job Entry > Job > Make To Stock > Detail sheet automatically update.
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e If ajob with Misc Shipment from WIP already exists and is linked to a different DMR Action or RMA Disposition,
the Job already has WIP to Misc Shipment demand linked to another DMR Action or RMA Disposition
message displays.

e |f you delete RMA Disposition the value in the RMA Line and RMA Number fields clear.
M Important You cannot delete RMA Disposition that is linked to a closed job.

* You won't be able to receive job to inventory or report quantity via MES.

[ Important Jobs that include multiple Make To Stock lines can be received to inventory or quantity
reported via MES only if one of those lines is not marked as Misc Shipment from WIP. If all the Make
To Stock lines are marked as Misc Shipment from WIP jobs cannot be received or quantity reported.

* You cannot link multiple RMAs/DMRs to the same job. If you do so, the RMA will not be fully linked to
Job demand link. Sync Job anyway? message displays.

e You cannot select this check box if you add a co-part. If you attempt to add a co-part while this check box is
selected, an error message displays.

The following rules apply if you clear the Misc Shipment from WIP check box:
e |f you Save after clearing the check box, the RMA and DMR related fields automatically clear.

Menu Path: Production Management > Job Management > General Operations > Job Entry

The Quality Assurance module ties together all quality functions, whether it is scrapping end parts, rejecting raw
materials, or tracking first article inspections.

Inspectors have queues of items to inspect with full disposition and corrective action follow-up. Shop floor
employees can indicate parts are non-conformant, which moves them into an inspection queue. Parts that fail
inspection may be selected for review by a material review board.

Return To Customer

Using DMR Processing you can return items to a customer

When you execute the Return To Customer for the failed material quantity on a DMR record, the application
automatically creates a Miscellaneous Shipment Pack ID and DMR-SHP transaction type.

e If the status of the miscellaneous shipment is Open, this quantity will be added to the current quantity in the
open miscellaneous shipment line.

e If the miscellaneous shipment has a status different than Open (Closed, Freight, Staged, Shipped), a new
miscellaneous shipment will be automatically created for this quantity.

Review the DMR-SHP transaction using the Part Transaction History Tracker.

The following rules apply:

e If a DMR record is not linked to an RMA record, you cannot execute Return to Customer. The New > Accept
- Return To Customer option is inactive.

* You cannot execute Return to Customer for closed DMR records.

* You can execute Return to Customer for parts on the fly.

e You cannot delete an accepted line. If you attempt to delete it, the 'Deletion of accepted lines (Stock, Material,
Operation or Return to Customer) not allowed." warning message displays.

* You can execute Return to Customer for parts that are serial and lot tracked.
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e When a miscellaneous shipment Pack ID is automatically created

B0 . Note If a part on a DMR record includes serial number(s) and you execute Return To Customer, the serial
number(s) move to the automatically created miscellaneous shipment Pack ID.

ﬁ Note You can review the Return To Customer information in the DMR Processing Tracker.

Menu Path: Production Management > Quality Assurance > General Operations > DMR Processing

Material Requirements Planning

Use the Material Requirements Planning (MRP) tools to both estimate potential demand and propose the supply
that answers this demand.

The MRP tools do this by generating job, purchase, and transfer order suggestions. MRP is designed primarily for
companies that manufacture make to stock quantities or for mixed-mode manufacturers that run both custom
and stock products. By using MRP, you can anticipate the future demand for your products and ensure materials
are in the right place at the right time.

Process MRP - Logging Type

Process MRP includes the Logging Type field where you can specify a logging type used during each MRP run.

Depending on the option you select in this field, the application will overwrite, add a date/time or content to log
files during each run. The field includes the following options:

¢ Append - Adds content at the end of the log files.
e Overwrite - Overwrites the log files during each run.

ﬁ Note This is a default option.

e Split - Adds a date and time in the filename to create separate log files for each run.

Menu Path: Production Management > Material Requirements Planning > General Operations > Process MRP

System Management

Use this area of functionality to maintain system-wide maintenance information. Examples of maintenance areas
include custom field maps, database records, menus, process calling, report data, report styles, sub process
menus, system agent and system monitor applications.

SQL Security Error Reporting

Changes have been made in possible error messages content, if the error is caused by security reasons.

Now no details that may reveal SQL server internals are displayed to an end user, when a query executes. User
only gets an invalid SQL statement, rest of details can be extracted from app server log only.
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The System Monitor sheets have been rearranged to get a more organized and more detailed display of report
information.

The History Tasks sheet includes the following sheets:

e Task Detail - Use this sheet to view task details for forms, processes and reports. For each task, information,
such as the task name and description, the task start and end times, the user who created the task and the
task status display.

e Report Detail - Use this sheet to review the details of the report or the report partition related to the task
currently selected in the Task Detail sheet.

e Report/Task Logs - Use this sheet to review the status of a task and any error messages that occur.
Once you submit a report for generation, the system monitor displays the submitted report on the Task Detail
sheet. Select the report instance from this sheet and go to the Report Detail sheet to view report details. If an

issue causes an error message to display, use the Report/Task Logs sheet to view a comprehensive listing of
error messages related to the selected report.

Epicor Cloud ERP enables In-App messaging for ERP application users. In-App messages are notifications displayed
while you are active within the ERP application itself. Use In-App notifications to get alerts about new features,
sales, training events, and more to stay informed about what is happening in Epicor.

[ Note Available only in Epicor Cloud ERP environment. This feature is expected to gradually roll out to
Epicor cloud users.

You can choose which kind of notifications you'd like to receive:

e Sales

o Offers

* Product Upgrades

¢ New Features

® Release Notes

e Training Events

e Training Videos

e Knowledge on Demand Videos

In addition to specifying the types of notifications you want to receive, you can also set up the application to
receive unigue notifications depending on your role in organization. With role-based notifications, marketing
and salespeople, for example, will only see sales-related content. Launch the System Monitor and use the

Actions > Notifications Preferences option to select your role and types of notifications you want to receive.
To display the list of all received notifications, click Actions > Open Notifications.

In-App notifications are an excellent way to engage you with helpful information in real-time. They serve as
product teams' primary form of communication.
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The System Setup module is important for setting up system-wide information, such as company, security
configuration, integration with external systems and other system level tasks.

Epicor Commerce Connect (ECC) is an eCommerce connector and toolset developed, implemented, and supported
by Epicor. It is a cross-brand solution that supports advanced B2C, B2B or B2B2C online commerce requirements,
and is integrated to multiple Epicor ERP platforms. ECC enables you to streamline, optimize and maximize your
business' potential, increase your Web presence and help drive new business—both from your existing customers
and from new, untapped business opportunities and sales channels.

With ECC, you can manage customers, merchandise, inventory, order history—basically the entire order life cycle.
Together with Epicor ERP, it enables you to effectively manage the entire customer experience. You no longer
need to have two separate systems to accept wholesale and consumer orders.

Product information tiered pricing, customers and inventory levels can be displayed directly from your production
ERP database. Orders can be submitted and processed immediately, allowing the customer to use their terms or
credit card for purchase. Epicor Commerce Connect also provides deep integration with your order fulfillment
process and makes it available to your customers online. At the time of requesting a quote or placing an order,
customers will be able to select the available shipping methods and determine their freight cost. Once the orders
are placed, online tracking allows them to see when their product was shipped and lets them track the shipment
through the carrier.

Upload Part Image to Epicor Commerce Connect

Web part images can now be sent to ECC in the STK Upload message. When this is done, a Cron task syncs the
parts. If a SYN request includes an <images> tag, it triggers the necessary FREQ request to obtain the part images
from ERP and upload them to ECC.

Part images for web-enabled parts are maintained in ERP and are synchronized between ERP and Epicor Commerce
Connect.

To synchronize a part image with ECC, the following information must be true:

* In the ECC Admin site, the Data Type for the FREQ File Request must be set to Data.
¢ |n Part Maintenance, the Web Saleable check box must be selected for each part to synchronize.
* In Part Maintenance, an image file must be selected in the Attributes sheet.

Use the Parts sheet in ECC Customer/Consumer Synchronization to initiate the synchronization process. You
can run the process manually, run it automatically on a schedule or set it to continuous processing.

To view an image uploaded to Epicor Commerce Connect, click Catalog > Manage Product and locate the
product by SKU. The images display on the left side menu.

W Note The part image synchronizes if a web-enabled part is added or the part file name is changed.

This new action in Menu Maintenance facilitates the process of setting up security for menu items.

You can now use this action to copy system security types and activate them in your current company.
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For cloud and on premise users of the Epicor ERP the system security records are disabled. This action menu
option copies the system security record to a new security record within owning company and enables its editing.

The following section contains a list of features released with the Epicor ICE platform. If you are upgrading from
a previous version, review this information to learn about the features added through this major version.

The Epicor Administration Console provides the ability to manage multiple Epicor server installations on multiple
physical servers from a single interface.

Epicor Administration Console can be installed on one or more computers and enables you to manage:

e Application databases
e Application servers
® Enterprise Search servers

[ Important This topic or section describes functionality or uses a process that is only available to on-premise
ERP installations.

FIPS 140-2 Encryption

Epicor ERP 10 now supports Federal Information Processing Standards (FIPS) 140-2 compliant encryption to meet
the security requirements of the customers operating under the International Traffic in Arms Regulation (ITAR).
FIPS encryption can be activated either on the operating system level in Windows Local Security Policy management
console or on the application level in Epicor Administration Console.

# . Important The customers, who are upgrading to Epicor ERP version 10.2.300 and want to use FIPS
encryption, need to request a new license compatible with FIPS restrictions mode and install it BEFORE
installing the upgrade.

Multiple EDD Sites

The Epicor Administration Console provides the ability to manage multiple Epicor Data Discovery instances on a
single application server.

Use the Extensions > Data Discovery sheet in the Administration Console to install multiple Data Discovery
sites.

Enterprise Search is a search application you use to retrieve indexed content from within your Epicor application.
You can search for any record within the Epicor database - like a part, customer, purchase order, AR invoice, and
so on. You can also search for text found in any record within the Epicor database. All the records within the
Epicor database that use this record in which this text is found display within the search results.

Other search programs within the Epicor application are limited to querying records for a specific record type;

for example, you need to launch Job Search in order to find and select job records. Through Enterprise Search,
however, you can find all the places within your Epicor database that reference a specific search item, and then
use links within the search results to display the search item you want within the application program you need.
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Data is indexed using a series of delivered Business Activity Queries (BAQs) that provide a starting point for the
primary data available when you first install the application. You can, however, extend this functionality by adding
user-defined BAQs into the indexing service.

ES Command Line Tool - Create Search Index

The ES command line tool allows you to create a new search index for the Enterprise Search. Search indexes are
the catalogs of application data on which Enterprise Search performs its searches.

Use the following commands to create and build new search indexes:

e C\Program Files (x86)\Comon Fil es\ Epi cor Software Corporation\Epicor
Enterpri se Search> ESCnd / Creat el ndex

e C\Program Files (x86)\Common Fil es\ Epi cor Software Corporation\Epicor
Enterprise Search> ESCnd /Buil dl ndex /s={I| ndexNane}

To delete an index, use:

e C\Program Files (x86)\ Comopn Fil es\ Epi cor Software Corporation\Epicor
Enterprise Search> ESCnhd / Del et el ndex /s={I| ndexNane}

Epicor Data Analytics (EDA) is an easy-to-use service that takes a unique, intuitive approach to lead you on a
journey of discovery through large data sets contained in your data warehouse.

EDA is fully integrated with Epicor 10 and uses data to help you understand your business better, with
function-specific content packs that provide a dashboard with deep integration into a specific set of Epicor 10
data - sales, purchasing, inventory, general ledger, accounts payable, accounts receivable and more.

EDA provides customizable and interactive dashboards to make it easy to analyze the data inside your business
systems. The dashboards contain visual KPIs, graphs, charts, and tables, so you can quickly review important
information about your business performance and make informed strategic decisions.

Sales Management Content Pack - CRM Quote Pipeline DB

The CRM Quote Pipeline database allows you to analyze the success of quote to order conversions, wins, losses,
and quotes status. It helps you to better understand your company's sales and enables you to make informed
decisions that will improve your sales process and grow your business.

Materials Management Content Pack - Enhanced Inventory DB

The inventory databases are enhanced to include monthly snapshot of the inventory information, MRP data, and
Sales data.

Inventory Snapshots

Use the EDA new snapshot to create the monthly snapshot of the inventory information.

MRP Data

This MRP information allows you to determine inventory levels based on actual information in the system or
suggested information based on the MRP system. Use the following measures to review the demand and receipt
information on parts:

e Measure 1
e Measure 2
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Sales Data

The following sales measures were added to the inventory databases:
e Extended Price

e Total Cost

e Net Sales

e Gross Margin

The Sales information allows for more efficient monitoring of how certain items are performing and improve
inventory control.

Finance Management Content Pack - Financial Statements DB

Use Financial Statements database to produce P&L Statement, Balance Sheet, Cash Flow, and Trial Balance
views. Available on the Finance Pack solution, the database displays consolidated financial statements in an
accounting format and integrating account-based streams with the usual EDA analysis tools.

Every new Financial Statements database opens with a template to get you started with the data loading and
mapping process. It comes with placeholders for streams, dimensions and properties.

[ Important The Financial Statements database requires certain streams, dimensions and properties for
financial statements to display correctly. Your data needs to fit into the usual accounting categories and
classifications, such as IAS 1.

This solution requires you to manually map accounting categories and classifications in an Excel sheet when
creating the Financial Statements database.

Epicor Data Discovery (EDD) is a Business Intelligence solution intended to provide an extremely easy to use
sense-making, data exploration, data visualization experience. EDD is a major component of the overall Epicor
Data Platform which encompasses a broad set of capabilities for managing, accessing, sharing, cleansing,
visualizing, and extracting insights from data created by or related to Epicor created data.

Command Line EDD

Use the Setup Environment command line tool to add the Epicor Data Discovery extension for use with each
application server.

To install Epicor Data Discovery, you need to launch the SetupEnvironmentUl.exe tool with a configuration
file. This configuration file can contain one or multiple tasks that you wish to run. You can install, update and
delete Epicor Data Discovery instances using this tool.

For information on how to install the EDD through a command line, review the Command Line Tools Guide.
This guide available in the application help:

e System Management > Working with System Management > Command Line Tools Guide

Data Discovery Dashboards

A Data Discovery Dashboard is a collection of several views, that enables you to compare a variety of data
simultaneously. If you have a set of views that you use daily, you can create a dashboard that displays all the
views at once, rather than navigate to separate views.

The visualizations on a dashboard include Discovery Chart Views and Discovery KPI Views.

10.2.300



10.2.300 Feature Highlights 10.2.300 Feature Highlights

When you create a dashboard, you have many options for changing the look and default behavior of the views
on that dashboard. You can resize and rearrange views, add filters which run in addition to any filters that already
exist in the view, and use shared dimensions.

Like views, you access dashboards from the Home Page. Use the Application Bar to switch between Discovery
View and Dashboard View.

Dashboards are secure and comply with the user security settings and restrictions.

EDD Advanced Edition

EDD Advanced allows you to dig deeper into data and find options you may have otherwise missed, such as
standalone deployment and security.

The key features include:

User security is independent of the ERP solution in the EDD Advanced version. Epicor Data Discovery can be
deployed in standalone AD integrated security modes without the need for a backing ERP system, so that
users without ERP credentials can use the system. If EDD is connected to an ERP system, the user is also able
to log in with the ERP's active mechanism.

You set up an Azure Active Directory Authentication or Local AD Authentication while you install Epicor Data
Discovery via a standalone installer. For more information, refer to the Epicor ERP Installation Guide.

Use the Administration > Standalone Authentication setting to verify if Epicor Data Discovery uses either
Azure Active Directory or Local Active Directory for authentication.

Administrators can create data level restrictions which restrict users or roles to filter on a particular dimension
member list, such as a list of sales territories.

[ Example You are an administrator and you want to restrict users in the Northwest Salespeople role
to view sales that are only in their own sales territory. To do this, you add a security rule by selecting a
dimension (sales territory), then selecting a list of dimension members (North West Territory), and then
associating that with an individual user or role. Then whenever a user in that role uses the datasource
with the restriction, a filter is added to their query automatically, which forces them to filter to this
member only.

Use the Administration > Data Security Management setting to create data security rules.

Administrators can limit users' capability to print and export data discovery views by using the Print claim
and Export Data as CSV claim on the Administration > Role > Edit Role page.

Misc Installation, UX

Multiple enhancements were implemented in Epicor Data Discovery to improve user experience.

10.2.300

Data Source Selection - \When you create a new view, the enhanced data source selection process enables
you to select the necessary data sources more quickly and easily by using the Search option on the Select
Data Source dialog box. You no longer need to wait for the data source to load the full list of sources. Better
data source organization allows you to pick the BAQ or cube you want to use as you type its name in the
search field. The search results display the name of the data source and the server where the data source is
installed.

System Views Redeployment - Use the Redeploy System View action in the Administration > Data
Sources window to reload system views if they were not deployed correctly during the installation or upgrade
process.
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The Epicor Web Access displays programs as web forms within a browser window and is a significant part of the
Epicor Everywhere™ Framework.

These forms are generated from Epicor ERP programs. Because of this, the appearance and functionality of the
Epicor Web Access forms is nearly identical to the Epicor smart client programs, but do not require the installation
of the Epicor client. You can run Epicor Web Access programs on multiple operating systems and on multiple
devices including handheld devices.

Routing Rules in EWA Reporting Forms

Use the Routing check box on the Epicor Web Access reporting forms to enable or disable advanced print routing
when submitting reports from Epicor Web Access.

A routing rule determines how the report output generates, prints, and distributes. Routing rules help you
streamline reporting for specific business needs. They can be simple rules that define an alternate report style
users run when they need to print a report using a unique format, or complex rules that divide, or break, the
report run into multiple dataset partitions which they can link to separate rendering workflows for generating,
printing, previewing, and sending the report output. Even though the report and data generation process only
runs once, you can render multiple reports from this data based on audiences, business requirements, and other
factors.

EWA Https Support

Starting with Epicor ERP 10.2.300, Epicor Web Access only supports secure connections using the https scheme.
u Example https:/<ServerName>/ERP102300-EWA/

Advanced Print Routing

Several enhancements have been introduced for Advanced Print Routing (APR).

Routing Confirmation Message

To help ensure against accidental execution of Advanced Print Routing actions, when you click the Print Preview,
Print, Email, or Generate button on the report, the Routing Enabled dialog box displays. Select the Do not
show this message again check box if you want to turn off the confirmation message. To re-enable the message,
go to Tools > Options > Dialogs and on the Printing sheet, select the Confirm When Advanced Print
Routing is enabled check box.

Routing to Multiple Email Addresses

When you add the e-mail routing action to a workflow, the routing rule then sends this e-mail to the multiple
users you defined on the e-mail template.

[ Example You are an account controller, and on printing an AR Invoice report, you would like to
automatically send the AR invoice email not only to the primary billing contact for the customer, but to all
contacts on the customer record. To do this, you add the ERP Customer Contact table to the Report Data
Definition and reference it in an APR e-mail action. All contacts listed in this table will receive the invoice
e-mail.
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When configuring the e-mail action in the Breaking and Routing Rules Designer for the To, CC, or BCC fields,
select All from the Records Select drop-down list in the E-mail Template dialog to construct a multi e-mail
address based on all rows from the chosen table.

To further filter the records, for example, customer contacts that qualify to receive an e-mail for a specific report,
use the filtering option available in the E-mail Template dialog. To filter contacts by a specific field, select your
desired field from the Filter drop-down list. You will then have the option to choose the value for that specific
field.

RDD Tables Available for APR Routing Actions

Values from tables defined via Report Data Definition relationships as parents of the APR Break table can now
be used for certain APR routing actions:

e Condition
e Take DocStar Attachment
e Add DocStar Attachment
e Send E-mail
[ Example
If your Report Data Definition has the following ERP tables:
e Company
¢ Invoice Header
e Invoice Details
e Customer
for which you have defined the following parent/child relationships:
e Company to Invoice Header

* |nvoice Header to Customer

and the Break table in the Report Style is set to Customer table, then both Company and Invoice Header
tables will be available for selection in APR actions highlighted above.

APR Actions Log

Use the Activity column on the History Tasks > Task Detail sheet in System Monitor to view the results of
Advanced Print Routing actions executed for the report. The details include the action name, number of actions,
and number of errors. For example:

Cient Print: 1, dient Printer Error: 0, Email Reports: 1, Enmmil Reports Error
0

Use the History Tasks > Report Details sheet to view more report details. If an error occurred during the report
execution, use the History Tasks > Report/Task Logs sheet to view the error details.
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Electronic Compliance Maintenance - Support XML Elements with Attribute and Value

Electronic Compliance file structure fully supports XML elements with both a value (bound data source value or
constant value) and one or more XML attributes (with bound data source values or constant values).

[ Example When you import a sample xml file, each element may contain one or more attributes. Values
specified for the attributes and elements can be imported as constants in the Electronic Compliance
definition:

<cbc:ProfilelD =urn:www.cenbii.eu:profile:bii05:ver2.0 < /cbc: ProfileID =
=chc:ID=>TOSL108 < /cbc:ID =
=cbc:IssueDate=2013-06-30</cbc:IssusDate
<cbc:InvoiceTypeCode listID="UNCL1001">2380</cbc:InvoiceTypeCode>
=cbc:Note=0rdered in our booth at the convention.</cbc:Note=
=chc:TaxPointDate=2013-06-30</cbc:TaxPointDate =
<cbc:DocumentCurrencyCode listID="IS04217">NOK</cbc:DocumentCurrencyCode>
<cbc:AccountingCost> Project cost code 123 </cbc:AccountingCost=
- <cac:InvoicePeriod >
<cbc:StartDate=2013-06-01</cbc:StartDate>
cche:FndDate = 2012-06-30< /cho:FndDatra =

In this example, for the InvoiceTypeCode element listID is an attribute and UNCL1001 will be imported
as a constant value. For the element value, 380 will be imported as a constant.

You can now modify an imported file structure by adding attributes at any XML level including lowest level child
elements. The attributes can be assigned constant values or be mapped to data source elements.

Edit SSRS Reports

To facilitate the process of modifying custom SSRS reports, including copies of standard reports, the SSRS reporting
functionality is extended with the option to generate a report for design only. The generated report appears on
the System Monitor. From here you launch the SSRS Report Design program that enables you to download
the SSRS Report Data Definition to a local working copy and interact with SSRS Report Builder (or SSRS Report
Designer) to modify the SSRS visual layout, save your local copy, and preview your working copy against the same
data originally extracted for the report generation. You can preview using output formats different from the
original execution. Once satisfied, your working copy can be uploaded to overwrite the live version of the custom
report.

This feature is secured so that the user must be explicitly allowed to edit reports before the option is available.

To implement this feature, the following changes were made:

User Account Security Maintenance

Use the Design SSRS Report check box in the Options sheet to grant the user access to the SSRS report designer
tools. This user can then create, download and upload the SSRS reports, as well as move reports between multiple
environments using Solution Workbench.

Verify the option is enabled when you access the following actions:
e Report Style Maintenance

e Actions > Create SSRS Report
e Actions > Download SSRS Report
e Actions > Upload SSRS Report

e BAQ Report Designer

e Actions > Download SSRS
e Actions > Upload SSRS Report
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Menu Path: System Setup > Security Maintenance > User Account Security Maintenance

Report Submission Form

For standard SSRS, BAQ, and Electronic Compliance reports, the submission form includes a new icon on the
standard toolbar and the Generate for Design option available on the File menu. Select this option to generate
a report for design only.

System Monitor

Once you submit the report for generation, use the Actions > Design SSRS Report menu option to launch the
SSRS Report Design program that enables you to modify the SSRS visual layout for the selected report.

Replaceable Report Logos

Use Image Maintenance and Report Style Maintenance to replace the logo that appears in a standard report
with your company logo.

When a company sends reports and documents to customers, they often want their company logo to appear at
the top of the report. It can be time consuming to maintain multiple custom reports and those reports can be
impacted by Epicor software updates.

In Epicor ERP, you can import logo images and then apply them to standard reports. When you preview or print
the report, your company logo appears at the top of the report. These reports are not custom and are not
impacted when you upgrade your application.

The standard image size is

e Width - 2.409 IN
e Height-0.533IN

To assign an image to a standard report, perform the following process:
* In Image Maintenance, import the logo image.

W Note You can set up a category for the logo in Image Category Maintenance.

¢ In Report Style Maintenance, perform the following steps:

e Select the standard report.

* In the Styles > Style Detail > Companies / Images sheet, click Retrieve and use the Images List to
select the logo image to appear on the report.

e C(lick Save.

This feature has been implemented on the following standard reports:
e Packing Slip

e Purchase Order

e Sales Order Acknowledgment

* AR Invoice

e (Customer Statements

e Supplier Statements

e Reminder Letter

e Debit Memo

10.2.300 65



10.2.300 Feature Highlights 10.2.300 Feature Highlights

Field Security Maintenance

The following topic describes key features for Field Security Maintenance.

Data Masking

Data Masking allows to limit access to sensitive data within particular fields. Only users with Security Manager

rights can define a security level for the whole organization, for the current company or for a selected user or
group of users.

Data Masking settings are applied to the sensitive data in BAQ. If display fields or calc fields contain masked
fields, then the query returns masked value.

BPM uses non-masked data and users should take Data Masking into account when using Show Message, Raise
Exception, and Send E-mail actions.

Epicor Kinetic Framework

Epicor Kinetic Framework is a new UX/Ul framework which offers a modern look and feel enabling developers
to create applications that work across any device.

Redesigned Active Home Page
A completely redesigned Active Home Page for Epicor ERP embodies Epicor Kinetic Design principles and lives as

a website accessible by Epicor partners and customers.

Delivering unified colors, typography and icons, user interface (Ul) elements, and page layouts, Epicor Kinetic
Design empowers partners to deliver value-added solutions consistent with Epicor usability best practices and
interaction guidelines to enhance customer experience.

2 Epicor
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Active Home Page is the starting point for a user logging in and is where most users will first encounter Epicor

Data Discovery. It contains quick access widgets for regularly used forms, links to other applications and resizable
Epicor Data Discovery card views.
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Four configurable home pages are provided for these role types: executive, financial, manufacturing, and supply
chain, and are populated with the appropriate favorites and Epicor Data Discovery card views.

The easy accessibility of Epicor Data Discovery from Active Homepage will promote data-driven decisions in your
business.

The Country Specific Functionality (CSF) is used to deliver localization capabilities for specific markets throughout
the world.

Each country contains topics which detail the Epicor ERP modifications created for the specified country. For
additional program information, refer to the topics in the Application Help.

The following section contains a list of CSF features released with the Epicor ERP application. If you are upgrading
from a previous version, review this information to learn about the features added through this major version.

The Belgium CSF delivers localized capabilities within Epicor ERP to support business operations in Belgium.

The Belgium CSF is used to produce the VAT Declaration Report and XML file to be submitted to the Belgian
government. It also supports payment reference numbers in AR and AP invoices, SEPA payment files, and localized
financial reports.

Automatic Matching of AP Payments

You can perform automatic matching of AP payments using banking reference number as a reference tag. You
can manually enter the banking reference number in the Invoice Entry program and then navigate to Invoice
Tracker > Header to see the reference in the Banking Reference field. If you want to perform the automatic
matching of AP payments, use the Bank Statement Processing program.

Menu Path: Financial Management > Accounts Payable > General Operations > Invoice Entry
Menu Path: Financial Management > Accounts Payable > General Operations > Invoice Tracker

Menu Path: Financial Management > Accounts Payable > General Operations > Bank Statement Processing

Automatic Matching of AR Payments

You can perform automatic matching of AR payments using banking reference number as a reference tag. This
number automatically generates in the Invoice Entry program and you can navigate to Invoice Tracker >
Header to see the reference in the Banking Reference field. If you want to perform the automatic matching
of AP payments, use the Bank Statement Processing program.

Menu Path: Financial Management > Accounts Receivable > General Operations > Invoice Entry
Menu Path: Financial Management > Accounts Receivable > General Operations > Invoice Tracker

Menu Path: Financial Management > Accounts Receivable > General Operations > Bank Statement Processing
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The India CSF delivers localized capabilities within Epicor ERP to support business operations in India.

The India CSF supports localization requirements for excise tax transactions and Central Sales Tax and Service
Tax requirements for a manufacturing plant. India CSF helps in calculation of excise duty, along with education
cess and higher secondary education cess on assessable value and on duty value for ECC registered manufacturers.

eWay Bill Functionality

Use the eWay Bill functionality to report movement of goods by means of electronic bills which can be generated
on the eWay Bill Governmental Portal. Transport of goods of more than Rs. 50,000 (single invoice/bill/delivery
challan) in value in a vehicle cannot be made by a registered person without an eWay bill.

This feature covers the following areas in the India CSF:
e eWay Bill Workbench

Use the eWay Bill Workbench program to generate electronic bills necessary for outward and inward movement
of goods.

Menu Path: Material Management > Shipping/Receiving > General Operations > eWay Bill Workbench
e eWay Bill Report

Use eWay Bill Report to list eWay Bill details for selected receipts, shipments and RMA

Menu Path: Material Management > Shipping / Receiving > eWay Bill List IN
e Transporter Tracker

Use the Transporter Tracker to view all shipments/receipts, eWay Bill details and statuses for the selected
transporter.

Menu Path: Material Management > Shipping / Receiving > General Operations > Transporter Tracker

The Denmark CSF delivers localized capabilities within Epicor ERP to support business operations in Denmark.

The Denmark CSF supports cash payment and receipt processes in Denmark. Use it to perform necessary calculations
to support the use of banking reference numbers (OCRs) when identifying invoices. You can use OCRs in AR
when you enter sales invoices, and import the resulting payment files, automatically matching a payment to an
OCR. You can use OCRs in AP when you enter purchase invoices, and import the resulting payment files to the
bank, including supplier OCRs.

Automatic Matching of AP Payments

You can perform automatic matching of AP payments using banking reference number as a reference tag. You
can manually enter the banking reference number in the Invoice Entry program and then navigate to Invoice
Tracker > Header to see the reference in the Banking Reference field. If you want to perform the automatic
matching of AP payments, use the Bank Statement Processing program.

Menu Path: Financial Management > Accounts Payable > General Operations > Invoice Entry
Menu Path: Financial Management > Accounts Payable > General Operations > Invoice Tracker

Menu Path: Financial Management > Accounts Payable > General Operations > Bank Statement Processing
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Automatic Matching of AR Payments

You can perform automatic matching of AR payments using banking reference number as a reference tag. This
number automatically generates in the Invoice Entry program and you can navigate to Invoice Tracker >
Header to see the reference in the Banking Reference field. If you want to perform the automatic matching
of AP payments, use the Bank Statement Processing program.

Menu Path: Financial Management > Accounts Receivable > General Operations > Invoice Entry
Menu Path: Financial Management > Accounts Receivable > General Operations > Invoice Tracker

Menu Path: Financial Management > Accounts Receivable > General Operations > Bank Statement Processing

The China CSF pack localizes the Epicor application to match the legal requirements needed to conduct business
in China.

After installation and set up of your China CSF pack, you can use the Epicor application to create financial reports
and data interface files required by the China Ministry of Finance.

You can set up an interface to upload files into the Golden Tax Invoice System (GTIS). It is possible to send Epicor
invoices to GTIS for printing, receive back modified files with invoice number for updating back to Epicor and
print GTIS Status Report.

A financial data export function is provided for sending financial information as described in standard GB/T
24589.1-2010 for exchange of data with authorities. The structure of the data and its compliance with reporting
requirements is dependent on having a China compliant chart of accounts, and having selected the appropriate
type of Income Statement and Balance Sheet for the company.

The system consolidates selected packing slips with existing not posted invoices and simultaneously checks the
invoice line limit and invoice limit.

You can specify the maximum amount of an AR invoice line and an AR invoice that your company is allowed to
issue. The specified amounts of each invoice and invoice line are verified against these amounts.

Booking Voucher Report Footer

The Booking Voucher CN report footers contain information on the users involved in transactions performing
the Maker, Checker, Book Keeper, and Cashier roles. The Maker and the Checker user names are normally
pulled from transaction details. If this information is not available, the system prints the user accounts defined
for these roles on the China sheet in Journal Code Maintenance. For the Book Keeper and Cashier user names,
the report uses the journal code record as the primary source.

When you run the Booking Voucher CN report, the system checks if the journal code associated with the
transactions have these roles defined to print them in the report footer. If you opt not to define these roles on
the Journal Code level, the system uses the accounts specified on the Modules > All Modules > Localization
> China > Data Interface sheet in Company Configuration.

Menu Path: Financial Management > General Ledger > Setup > Journal Code

The Colombia CSF delivers localized capabilities within Epicor ERP to support business operations in Colombia.

After the installation and setup of the Colombia CSF, you can use Epicor ERP to add one-time supplier and
customer entries, enter one-time transactions into journals, and run fiscal reports sorted by one-time information.
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Lower of Cost or Net Realizable Value

The Lower of Cost or Net Realizable Value (LCNRV) report shows the difference between the cost of an
individual part/part class and their Net Realizable Value (NRV).

NRV is calculated as sales price minus sales fee.

Parts are included into the Inactive Sales Items report if AR invoice or part estimated price cannot be found.

Menu Path : Material Management > Inventory Management > Reports > LCNRV Report CO

Electronic Invoicing

You can set up configurations for electronic invoicing to automatically send your company's AR invoices, credit
memos, and debit notes to the authorized certification provider (PAC) in accordance with Colombian governmental
regulations.

Electronic invoicing functionality is available after you set up your PAC in PAC Configuration, choose it in
Company Configuration, and choose a DIAN code in Tax Type Maintenance. You can create different types
of electronic invoices (miscellaneous invoices, credit memos, and debit notes) in AR Invoice Entry and review
their details in AR Invoice Tracker and Posted Invoice Update.

Menu Path: System Setup > Company/Site Maintenance > Company Configuration

Menu Path : System Setup > Company/Site Maintenance > PAC Configuration CO

Menu Path: Financial Management > Accounts Receivable > Setup > Tax Type

Menu Path: Financial Management > Accounts Receivable > General Operations > Invoice Entry
Menu Path: Financial Management > Accounts Receivable > General Operations > Invoice Tracker

Menu Path: Financial Management > Accounts Receivable > General Operations > Posted Invoice Update

Customs Clearance Lots

The Customs Clearance Lots program enables you to enter and review Customs Clearance documents and to
create lots of parts for which Customs Clearance documents are issued.

Customs Clearance is the documented permission given by the national Customs that enables imported goods
to enter the country and exported goods to leave the country.

If you want to use this functionality, you need to primarily download and install the solution files in Solution
Workbench.

Menu Path : Material Management > Shipping/Receiving > Setup > Custom Clearance Lots

The DanskeBank CSF enables Epicor ERP to implement a unified DanskeBank transactions format in an Electronic
Funds Transfer (EFT) payment output file for credit transfer.

Danske Bank is the largest bank in Denmark and a major retail bank in the Northern European region, where it
operates a number of local banks. Danske Bank has a unified protocol of performing EFT payments that enables
customers to make cashless payments in the countries' currencies using only a single bank account and a single
set of payment tools.

DanskeBank format provides a generic standard for headers, trailers, and line items for EFT in the Northern Europe
Area using the single payment function. The messages are based on the ISO 20022 standard, of which DanskeBank
uses a subset.
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DanskeBank format is available for the following countries:

e Denmark
e Finland
¢ Norway
e Sweden

The Estonia CSF delivers localized capabilities within Epicor ERP to support business operations in Estonia.

The Estonia CSF automatically loads localized report formats used to modify AR invoice processing and to support
use of bank or account reference numbers. These reference numbers identify the specific invoice being paid, or
for large suppliers (such as Estonian Energy) the account being paid. You can enter bank reference numbers on
AR and AP invoices. You can also use the Telehansa Domestic Payment File Formats to electronically pay AP
invoices in Estonia.

Automatic Matching of AP Payments

You can perform automatic matching of AP payments using banking reference number as a reference tag. You
can manually enter the banking reference number in the Invoice Entry program and then navigate to Invoice
Tracker > Header to see the reference in the Banking Reference field. If you want to perform the automatic
matching of AP payments, use the Bank Statement Processing program.

Menu Path: Financial Management > Accounts Payable > General Operations > Invoice Entry
Menu Path: Financial Management > Accounts Payable > General Operations > Invoice Tracker

Menu Path: Financial Management > Accounts Payable > General Operations > Bank Statement Processing

Automatic Matching of AR Payments

You can perform automatic matching of AR payments using banking reference number as a reference tag. This
number automatically generates in the Invoice Entry program and you can navigate to Invoice Tracker >
Header to see the reference in the Banking Reference field. If you want to perform the automatic matching
of AP payments, use the Bank Statement Processing program.

Menu Path: Financial Management > Accounts Receivable > General Operations > Invoice Entry
Menu Path: Financial Management > Accounts Receivable > General Operations > Invoice Tracker

Menu Path: Financial Management > Accounts Receivable > General Operations > Bank Statement Processing

The Finland CSF delivers localized capabilities within Epicor ERP to support business operations in Finland.

Use the Finland CSF to perform necessary calculations to support the use of banking reference numbers (OCRs)
to identify invoices. You enter AR and AP invoices with OCRs and process electronic cash receipt files (AR payment
files, domestic AP payment files, and international AP payment files).

Automatic Matching of AP Payments

You can perform automatic matching of AP payments using banking reference number as a reference tag. You
can manually enter the banking reference number in the Invoice Entry program and then navigate to Invoice
Tracker > Header to see the reference in the Banking Reference field. If you want to perform the automatic
matching of AP payments, use the Bank Statement Processing program.

10.2.300 71



10.2.300 Feature Highlights 10.2.300 Feature Highlights

72

Menu Path: Financial Management > Accounts Payable > General Operations > Invoice Entry
Menu Path: Financial Management > Accounts Payable > General Operations > Invoice Tracker

Menu Path: Financial Management > Accounts Payable > General Operations > Bank Statement Processing

Automatic Matching of AR Payments

You can perform automatic matching of AR payments using banking reference number as a reference tag. This
number automatically generates in the Invoice Entry program and you can navigate to Invoice Tracker >
Header to see the reference in the Banking Reference field. If you want to perform the automatic matching
of AP payments, use the Bank Statement Processing program.

Menu Path: Financial Management > Accounts Receivable > General Operations > Invoice Entry
Menu Path: Financial Management > Accounts Receivable > General Operations > Invoice Tracker

Menu Path: Financial Management > Accounts Receivable > General Operations > Bank Statement Processing

AOS2 Format for Nordea AP Payments

You can use the Additional Optional Service 2 (AOS2) format for Nordea AP Payments. The AOS2 format allows
to add structured remittance information in case when a payment contains two or more invoices and at least
one debit memo.

You can set up Nordea AP Payment Method with AOS2 format in Payment Method Maintenance.

Menu Path: Financial Management > Accounts Payable > Setup > Payment Method

The Germany CSF pack localizes the Epicor application to match the legal requirements needed to conduct
business in Germany.

After installation and set up of your Germany CSF pack, you can use the Epicor application to support value add
tax (VAT) functionality and reporting, as well as electronic funds transfer (DTAU) processing. You can also use
the Epicor application to support GDPDU processing. This includes providing an export file with line details for
General Ledger verification, based on the natural account.

The Region of origin parameter can be specified now in the Part Maintenance program. It is required to create
Intrastat transactions in AR and AP. New intrastatExport-DE.p routine is available in the Server\El folder. It
enables you to set up electronic interface for exporting the Intrastat report.

When you adjust an AR invoice, it is possible to select a document type for the adjusted invoice. If a legal number
is set for the selected document type, then all legal number information is updated accordingly when a legal
number is generated. The Red Storno value is defined by the selected document type.

Those who are using the Epicor e-Bilanz product can create the electronic interface and data export to link with
this product.

Germany Specific Data Import
The Epicor ERP 10 installation package now provides the files you can use to populate your database with primary
data for Germany CSF:

e Intrastat-DE_Epicor CSF_10.02.300.cab contains the updated Intrastat user defined codes. You install it
using Solution Workbench.

e Germany_COAData.xlIsx includes the Chart of Accounts and related settings. Import this file in COA Import.
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¢ DELookupData.10.2.300.xlsx provides standardized lookup data for UOM Classes, UOM Conversions, UOMs,
FOB, Ship Via, and Country codes. You can import this data using the Lookup Data Import program.

All files are copied to your system with the installation package and are located in the <Epicor
ERP>\server\Erp\CSF\DE\ folder on your server.

Menu Path: System Management > Solution Management > Solution Workbench
Menu Path: Financial Management > General Ledger > Setup > COA Import

Menu Path: System Management > Rebuild Processes > Finance > Lookup Data Import DE

Lookup Data Import and Export

The Lookup Data Import and Lookup Data Export programs are now available for Germany CSF providing
the ability to import and export standardized lookup data for UOM Classes, UOM Conversions, UOMs, FOB, Ship
Via, and Country Codes.

Note that the import process does not validate imported values, so after importing a file, you should manually
verify that referenced data is entered into the system.

Menu Path: System Management > Rebuild Processes > Finance > Lookup Data Import DE

Menu Path: System Management > Rebuild Processes > Finance > Lookup Data Export DE

FIFO Stock Movement Report

The FIFO Stock Movement report shows FIFO transactions per part for a given period of time. The report displays
various values related to part transactions, so you can track and analyze them for the future usage.

Menu Path: Material Management > Inventory Management > Report > FIFO Stock Movement DE

Part FIFO Transaction History Tracker DE
Use the Part FIFO Transaction History Tracker DE program to review current information about selected part
records.

Menu Path: Material Management > Inventory Management > General Operations > Part FIFO Transaction
History Tracker DE

The Malaysia CSF pack localizes the Epicor application to match the legal requirements needed to conduct business
in Malaysia.

After installation and set up of your Malaysia CSF pack, you can use the Epicor application to designate lot-tracked
parts for Sales Tax Exemption (CJ5) processing, License Manufactured Warehouses (LMW) processing, or both.
The lot-tracked parts are then reflected in various localization reports created according to local regulations. The
localization reports include the CJ5 report to list the goods being manufactured and the LMV reports to track
finished goods activity of LMW.

Deemed Supply Reporting

Use the Deemed Supply Report MY program to run reports for the taxable sales with the DS (Deemed Supply)
tax code or tax rate code applied. The report shows all records for the period you specify.

Menu Path: Financial Management > Accounts Receivable > Reports > Deemed Supply Report MY

You can also view the details of Deemed Supply sales in the Deemed Supply MY Tracker.

Menu Path: Financial Management > Accounts Receivable > General Operations > Deemed Supply MY
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Tax Box 15

Starting with 01/01/2018, item 15 of GST-03 return should display the total value of other supplies, such as
disregarded supplies, supplies under Approved Jeweler Scheme, and supplies made outside Malaysia or not within
the scope of GST.

When you run the Tax Box report ( the Standard MY GST Return - SSRS and Standard MY- SSRS report styles),
the value of item 15 depends on the To Date. When the To Date is before 01/01/2018, the value is calculated
as 6% from the value of Tax Box 14 independently on the real value accumulated in the tax box 15. When the
To Date is 01/01/2018 or later, the item includes the total value of tax box 15, which is accumulated based on
the settings of other supplies (tax rate codes OS, GS, OS-TXM, NTX, and SR-JWS).

The Mexico CSF delivers localized capabilities within Epicor ERP to support business operations in Mexico.

After the installation and setup of your Mexico CSF, you can use Epicor ERP to support digital tax receipts,
automatic calculation of ISR (corporate tax), and localization reports. The localization reports comply with basic
regulations to complete taxes for SAT (Servicio de Administracion Tributaria) compliance in Mexico.

Customs UOM in Electronic International Trade CFDI Supplement XML

When the Unit of Measure (UOM) in which you sell goods is different from the one required by the International
Trade Supplement, you should specify the UOM to use for reporting in the Get Customs UOM from field on
the Mexico sheet in Part Maintenance. You can select Sales UOM, Unit Net Weight, Unit Gross Weight, or
Unit Net Volume. The system uses the selected option to determine UOM code and the specified value to
recalculate the amount and price for Customs.

Alternatively, you can define the UOM for Customs in AR Invoice Entry on the Line > Mexico sheet.
Menu Path: Material Management > Inventory Management > Setup > Part

Menu Path: Financial Management > Accounts Receivable > General Operations > Invoice Entry

Payment Tracker MX
Use Payment Tracker MX to retrieve and review AP payment records. You can specify the records you wish to
review using Advance Search fields.

Menu Path: Financial Management > Accounts Payable > General Operations > Payment Tracker MX

Update Payment Fiscal Folio MX
Use Update Payment Fiscal Folio MX to review imported XML files, match them with the AP payments either
automatically or manually, and then update selected AP payments with the UUID information.

Menu Path : Financial Management > Accounts Payable > General Operations > Update Payment Fiscal Folio
MX

Customs Clearance Lots

The Customs Clearance Lots program enables you to enter and review Customs Clearance documents and to
create lots of parts for which Customs Clearance documents are issued.

Customs Clearance is the documented permission given by the national Customs that enables imported goods
to enter the country and exported goods to leave the country.
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If you want to use this functionality, you need to primarily download and install the solution files in Solution
Workbench.

Menu Path : Material Management > Shipping/Receiving > Setup > Custom Clearance Lots

The Netherlands CSF delivers localized capabilities within Epicor ERP to support business operations in the
Netherlands.

Digipoort Digital Certificate Store

Use the Digital Certificate Store program to load Digipoort certificates used for Dutch reports. After you add
the required certificates, you need to proceed with setting up their properties in Company Configuration on
the Modules > All Modules > Localization > Netherlands sheet.

Menu Path: System Setup > Company/Site Maintenance > Digital Certificate Store

Menu Path: System Setup > Company/Site Maintenance > Company Configuration

The Nordea CSF enables Epicor ERP to implement a unified Nordea transactions format in an Electronic Funds
Transfer (EFT) payment output file for credit transfer.

Nordea Bank (or Nordea) is a financial services group that operates in Northern Europe and is represented by a
number of banks and companies there. Nordea has a unified protocol of performing EFT payments that enables
customers to make cashless payments in the countries' currencies using only a single bank account and a single
set of payment tools.

Nordea format provides a generic standard for headers, trailers, and line items for EFT in the Northern Europe
Area using the single payment function. The messages are based on the I1SO 20022 standard, of which Nordea
uses a subset.

Nordea format is available for the following countries:

e Denmark
e Finland
e Norway
e Sweden

The Norway CSF delivers localized capabilities within Epicor ERP to support business operations in Norway.

Use the Norway CSF to make payments using TelePay payment methods, import AP and AR bank files, generate
electronic invoices, and run Norway localization reports.

Automatic Matching of AP Payments

You can perform automatic matching of AP payments using banking reference number as a reference tag. You
can manually enter the banking reference number in the Invoice Entry program and then navigate to Invoice
Tracker > Header to see the reference in the Banking Reference field. If you want to perform the automatic
matching of AP payments, use the Bank Statement Processing program.

Menu Path: Financial Management > Accounts Payable > General Operations > Invoice Entry

Menu Path: Financial Management > Accounts Payable > General Operations > Invoice Tracker
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Menu Path: Financial Management > Accounts Payable > General Operations > Bank Statement Processing

Automatic Matching of AR Payments

You can perform automatic matching of AR payments using banking reference number as a reference tag. This
number automatically generates in the Invoice Entry program and you can navigate to Invoice Tracker >
Header to see the reference in the Banking Reference field. If you want to perform the automatic matching
of AP payments, use the Bank Statement Processing program.

Menu Path: Financial Management > Accounts Receivable > General Operations > Invoice Entry
Menu Path: Financial Management > Accounts Receivable > General Operations > Invoice Tracker

Menu Path: Financial Management > Accounts Receivable > General Operations > Bank Statement Processing

Transaction Reason Codes for Nordea Payment
You can select a transaction reason code when you create an AP Invoice for a cross-border payment. A transaction
reason code is selected from the list defined in TranReason user codes.

Menu Path: Financial Management > Accounts Payable > General Operations > Invoice Entry

Transaction Reason Codes for DanskeBank Payment
You can select a transaction reason code when you create an AP Invoice for a cross-border payment. A transaction
reason code is selected from the list defined in TranReason user codes.

Menu Path: Financial Management > Accounts Payable > General Operations > Invoice Entry

SAF-T Financial Functionality

Use the SAF-T Report program to create a SAF-T report, generate an XML file and submit it.
The cab file that you import into Epicor ERP contains the user defined codes that you use to set up SAF-T data.
The following setup programs display the Norway sheet where you select required data:

e Tax Type Maintenance
e Account Segment Value

Menu Path: Financial Management > General Ledger > Reports > SAF-T Financial NO

The Portugal CSF delivers localized capabilities within Epicor ERP to support business operation in Portugal.

The Portugal CSF supports generation of SAF-T XML files according to the PT v1.04_01 XML schema. SAF-T is a
taxation audit file generated by the invoicing system and handed over to tax authorities. A SAF-T file contains all
the financial and taxation data that a company has over a certain financial period (a month, a quarter, or a
financial year).

76 10.2.300



10.2.300 Feature Highlights 10.2.300 Feature Highlights

Cash Receipt Tracker

You can use Cash Receipt Tracker to print out AR remittance slips for posted cash receipts in Portugal-specific
report style.

Configuration Settings PT

Configuration Settings PT enables you to set default configuration settings for Company Configuration and
User Account Security Maintenance and to upload legal numbers and transaction document types provided by
Epicor ERP to your database.

Configurations Settings PT is an obligatory part of the installation process. You must launch the Configuration
Settings PT process one time before you start to use other programs.

Menu Path: System Setup > Company/Site Maintenance > Configuration Settings PT

Sales Order Entry
The Sales Order Entry program enables you to create, edit, digitally sign, and print sales orders and pro-forma
invoices.

You can edit the orders and pro-forma invoices that have not been digitally signed. After you digitally sign the
document, no further changes are allowed.

You can invoice or ship only digitally signed sales orders or pro-forma invoices.

Menu Path: Sales Management > Order Management > General Operations > Order Entry

Sign and Generate Transport Document

You can use the Sign and Generate Transport Document command of the Actions menu to automatically
sign and generate a transport document for a selected customer, miscellaneous, subcontractor, and transfer
order shipment.

Menu Path: Material Management > Shipping / Receiving > General Operations > Customer Shipment Entry

Menu Path: Material Management > Shipping / Receiving > General Operations > Miscellaneous Shipment
Entry

Menu Path: Material Management > Shipping / Receiving > General Operations > Subcontractor Shipment
Entry

Menu Path: Material Management > Shipping / Receiving > General Operations > Transfer Order Shipment
Entry

Transaction Document Type Maintenance
You can define document types assigned to legal number sequences.

Epicor ERP provides a set of predefined transaction document types that you are recommended to use as default
settings. These document types follow all SAF-T schemas requirements and they are automatically linked to legal
numbers. You upload the transaction document types to your database using Configuration Settings PT.

Menu Path: System Setup > Company/Site Maintenance > Configuration Settings PT
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The Sweden CSF delivers localized capabilities within Epicor ERP to support business operations in Sweden.

The Sweden CSF automatically performs many necessary calculations to support the use of banking reference
numbers or OCRs to identify invoices. You can use OCRs to create AP invoices and import the resulting payment
files, automatically matching the payment to an OCR. When you create AP invoices, you can enter suppliers'
OCRs and export resulting payment files to the bank.

Automatic Matching of AP Payments

You can perform automatic matching of AP payments using banking reference number as a reference tag. You
can manually enter the banking reference number in the Invoice Entry program and then navigate to Invoice
Tracker > Header to see the reference in the Banking Reference field. If you want to perform the automatic
matching of AP payments, use the Bank Statement Processing program.

Menu Path: Financial Management > Accounts Payable > General Operations > Invoice Entry
Menu Path: Financial Management > Accounts Payable > General Operations > Invoice Tracker

Menu Path: Financial Management > Accounts Payable > General Operations > Bank Statement Processing

Automatic Matching of AR Payments

You can perform automatic matching of AR payments using banking reference number as a reference tag. This
number automatically generates in the Invoice Entry program and you can navigate to Invoice Tracker >
Header to see the reference in the Banking Reference field. If you want to perform the automatic matching
of AP payments, use the Bank Statement Processing program.

Menu Path: Financial Management > Accounts Receivable > General Operations > Invoice Entry
Menu Path: Financial Management > Accounts Receivable > General Operations > Invoice Tracker

Menu Path: Financial Management > Accounts Receivable > General Operations > Bank Statement Processing

Regulatory Reporting Codes for Nordea AP Payment

You can create regulatory reporting codes for Nordea cross-border payments.

Regulatory reporting codes are required when you create a Nordea cross-border payment in Payment Entry.
You can create regulatory reporting codes in User Defined Codes Maintenance.

Menu Path: System Setup > System Maintenance > User Codes

Regulatory Reporting Codes for DanskeBank AP Payment

You can create regulatory reporting codes for DanskeBank cross-border payments.

Regulatory reporting codes are required when you create a DanskeBank cross-border payment in Payment Entry.
You can create regulatory reporting codes in User Defined Codes Maintenance.

Menu Path: System Setup > System Maintenance > User Codes

The Switzerland CSF delivers localized capabilities within Epicor ERP to support business operations in Switzerland.

The Switzerland CSF loads localized files that support Electronic Funds Transfer (EFT) processing of AP payments
in Switzerland. Swiss internal business processes are based on OCR codes called Inpayment Slip with Reference
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number (ISR), which are processed by either Postfinance or Swiss banks. Invoices for Swiss and Liechtenstein-based
customers contain a payment slip with ISR code attached to them, which provide unique information.

You can use Epicor ERP to store data to generate ISR code line and reference number for companies, to store
suppliers' ISR party numbers, to generate AP payment files with ISR numbers, and to import AR payment files
with ISR reference numbers.

Automatic Matching of AP Payments

You can perform automatic matching of AP payments using banking reference number as a reference tag. You
can manually enter the banking reference number in the Invoice Entry program and then navigate to Invoice
Tracker > Header to see the reference in the Banking Reference field. If you want to perform the automatic
matching of AP payments, use the Bank Statement Processing program.

Menu Path: Financial Management > Accounts Payable > General Operations > Invoice Entry
Menu Path: Financial Management > Accounts Payable > General Operations > Invoice Tracker

Menu Path: Financial Management > Accounts Payable > General Operations > Bank Statement Processing

Automatic Matching of AR Payments

You can perform automatic matching of AR payments using banking reference number as a reference tag. This
number automatically generates in the Invoice Entry program and you can navigate to Invoice Tracker >
Header to see the reference in the Banking Reference field. If you want to perform the automatic matching
of AP payments, use the Bank Statement Processing program.

Menu Path: Financial Management > Accounts Receivable > General Operations > Invoice Entry
Menu Path: Financial Management > Accounts Receivable > General Operations > Invoice Tracker

Menu Path: Financial Management > Accounts Receivable > General Operations > Bank Statement Processing

The Taiwan CSF pack localizes the Epicor application to match the legal requirements needed to conduct business
in Taiwan.

After installation and set up of your Taiwan CSF pack, you can use the Epicor application to support Taiwan's

valued added tax (VAT) system, the required Uniform Invoice Numbers (UIN) assigned to invoices, and Taiwan

localization reports. New programs are introduced - Tax Declaration Maintenance with new processes AR Data
Post to Tax Declaration and AP Data Post to Tax Declaration, AR Invoice Check List, and AP Invoice Check List.
You can now import Taiwan CSF data from User Code Maintenance. New functionalities are introduced in this
release - company configuration, document type maintenance, and supplier maintenance.

Lower of Cost or Net Realizable Value

The Lower of Cost or Net Realizable Value (LCNRV) report shows the difference between the cost of an
individual part/part class and their Net Realizable Value (NRV).

NRV is calculated as sales price minus sales fee.

Parts are included into the Inactive Sales Items report if AR invoice or part estimated price cannot be found.

Menu Path : Material Management > Inventory Management > Reports > LCNRV Report TW
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The Thailand CSF pack localizes the Epicor application to match the legal requirements needed to conduct business
in Thailand.

After installation and set up of your Thailand CSF pack, you can use the Epicor application to support Thailand's
valued added tax (VAT) system, including issuing withholding tax certificates and processing various localization
reports.

Document Options on Monthly VAT Report

The payment documents including tax may have several numbers assigned, such as Invoice Number, Tax Receipt
Number, Reference Invoice Number, and so on. The Monthly VAT TH Report options have been enhanced to
allow selecting the type of number to print as the Document Number on the report. You can also specify whether
the Document Date should originate from the record Apply Date, Tax Point Date, or Transaction Date. The records
on the report can be sorted by the Document Date or the Document Number.

Menu Path: Financial Management > Accounts Payable > Reports > Monthly VAT Report TH

Lower of Cost or Net Realizable Value

The Lower of Cost or Net Realizable Value (LCNRV) report shows the difference between the cost of an
individual part/part class and their Net Realizable Value (NRV).

NRV is calculated as sales price minus sales fee.

Parts are included into the Inactive Sales Items report if AR invoice or part estimated price cannot be found.

Menu Path : Material Management > Inventory Management > Reports > LCNRV Report TH

Part Descriptions in BOM Listing Report
A new report style Standard TH - SSRS is available for the Bill of Material Listing Report. You should select
it to have the full description of the part components displayed in the report.

If you select the Standard - SSRS option, the descriptions may be truncated and may not comply with the ones
provided in Part Maintenance.

Menu Path: Production Management > Engineering > Reports > BOM Listing

Withholding Taxes in Report and Certificate

Now withholding taxes for miscellaneous payments are supported similar to invoice payments. When you run
the Withholding Tax Report or create Withholding Tax Certificate, and several tax types apply to the payment
included in the document, all of them are printed in the same payment line.

You can also select the types to include in Withholding Tax Report on the Filter sheet. By default all tax types
are selected.

Menu Path: Financial Management > Accounts Payable > Reports > Withholding Report TH

Menu Path: Financial Management > Accounts Payable > Reports > Withholding Tax Certificate TH
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The United Kingdom CSF delivers localized capabilities within Epicor ERP to support business operations in the
United Kingdom.

Use the United Kingdom CSF to set up and export the Intrastat report that uses UK-specific Intrastat user-defined
codes.

CIS Monthly Return Dashboard UK

The CIS Monthly Return Dashboard UK program enables to retrieve and review the data used to generate
the report export files in the CIS Monthly Return Report UK program.

Menu Path: Financial Management > Account Payable > General Operations > CIS Monthly Return Dashboard
UK

CIS Monthly Return Report UK

The CIS Monthly Return Report UK program enables to generate monthly report export files on all payments
that your company makes to subcontractors and submit them to Her Majesty's Revenue and Customs (HMRC).

Before using this report, you must install the solution files for CIS functionality in Solution Workbench and
complete the settings in Company Configuration in the Modules > All Modules > Localization > United
Kingdom sheet and in Supplier Maintenance in the United Kingdom sheet.

Menu Path: Financial Management > Accounts Payable > Reports > CIS Monthly Return Report UK

Payment and Deduction Statement UK Report

The Payment and Deduction Statement UK report enables to list the payments and Withholding Tax deductions
that your company made to each supplier within a given time interval.

You can send this report to your subcontractors in order to inform them of all the deductions taken under the
regulations of the Construction Industry Scheme (CIS).

Before using this report, you must install the solution files for CIS functionality in Solution Workbench and
complete the settings in Company Configuration in the Modules > All Modules > Localization > United
Kingdom sheet and in Supplier Maintenance in the United Kingdom sheet.

Menu Path: Financial Management > Accounts Payable > Reports > Payment and Deduction Statement UK

The Peru CSF localizes the Epicor ERP application to match the legal requirements needed to conduct business
in Peru.

After the installation and setup of the Peru CSF, you can use Epicor ERP to create and process bills of exchange,
pre-payment invoices to pay the Customs Unique Declaration (DUA) agency for products bought from vendors
that are not located in Peru, and non-resident invoices for services provided from vendors that are not based in
Peru. We also support Retenciones and Detracciones Withholding Taxes, Peru Purchase Accounting, and Late
Cost and Invoice Price Variance allocation to Inventory.
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Withholding Tax Calculation in Payment Instrument

Epicor ERP can now calculate Peruvian withholding tax types, such as Retentions, Perceptions, and Detractions,
when you enter AP payments using Payment Instrument Payable Entry. The calculation process works in the
same way as in the AP Payment Entry program.

Note that to be able to use this functionality, you first need to set up the required Peruvian tax types and assign
them to product tax categories.

Menu Path
Navigate to this program from the Main Menu:

¢ Financial Management > Accounts Payable > General Operations > Payment Instrument

Customs Clearance Lots
The Customs Clearance Lots program enables you to enter and review Customs Clearance documents and to
create lots of parts for which Customs Clearance documents are issued.

Customs Clearance is the documented permission given by the national Customs that enables imported goods
to enter the country and exported goods to leave the country.

If you want to use this functionality, you need to primarily download and install the solution files in Solution
Workbench.

Menu Path : Material Management > Shipping/Receiving > Setup > Custom Clearance Lots

The Singapore CSF delivers localized capabilities within Epicor ERP to support business operations in Singapore.

The Singapore CSF automatically performs many necessary calculations, and loads files to Singapore-specific
features. IRAS (Inland Revenue Authority of Singapore) audits businesses from time to time to assure that businesses
are making correct tax declarations. It is a common procedure for IRAS to request for certain accounting information
as part of the audit. Use the Data Export Tool functionality to produce an IRAS audit File (IAF).

UOB Payment Processing
With Singapore CSF, you can create Electronic Fund Transfer (EFT) files to pay Supplier invoices through UOB
service. Such files may contain information on the Service Type, Payment Advice, and Transaction Code.

You enter the required banking information and define file settings on the Singapore sheets in AP Payment
Entry. When you use the Actions > Process Payments command, an electronic payment file which can be sent
to UOB is created.

Note that prior to using this functionality, you need to import the UOB payment format in Solution Workbench,
set up an Electronic Interface for UOB Payment, create UOB Payment Method and Bank Account.

Menu Path: Financial Management > Accounts Payable > General Operations > Payment Entry

The United States CSF delivers localized capabilities within Epicor ERP to support 1099 forms and reporting in
the United States.

1099 forms are legally required in the United States. There are many different types of information returns, and
each type is used to report a different type of payment or transaction. Most information returns fall within the
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1099 series of forms. Besides the existing 1099-Misc (Miscellaneous Income) form, additional 1099 forms could
be required.

The Internal Revenue Service (IRS) requires businesses to file a 1099 form to report certain payments made to
individuals and organizations. Whether a payment is reportable on Form 1099 depends upon the payment
amount, payment type and the supplier's business entity type. In order to facilitate the tax reporting process and
provide a way to fulfill IRS regulations, AP1099 functionality has been enhanced in the Epicor ERP application
with a United States CSF license. This functionality includes 1099 setup, processing, and reporting. Epicor provides
three predefined 1099 forms: 1099-Misc, 1099-DIV, and 1099-INT. You can also add other required forms.

AP Open Invoices With 1099 Details

When you enter AP Invoices that were created outside the Epicor application in the AP Open Invoice Load
program, you can provide the 1099 Type and Code information and mark such invoices as paid on the USA
sheet. Default 1099 values are taken from the Supplier record.

After you post the paid invoices, the system includes them in all 1099 report calculations along with ordinary
paid AP invoices.

Menu Path: Financial Management > Accounts Payable > Setup > Open Invoice Load

This section describes programs designed specifically for ERP and the ICE framework, programs designed for ERP
and other Epicor products, and integrations to third-party products. These programs extend the base functionality
of your ERP application.

Epicor Mobile CRM is a Companion Mobile Application designed to implement the Epicor ERP 10 back office
CRM capability optimized for Mobile devices. The application leverages a RESTful services model to connect
directly to the back office business logic offering real time transactions.

The Mobile CRM Application is directly connected to your Back Office system ensuring real-time access to live
data. All transactions from Mobile CRM are updated directly to the Back Office ensuring that the Mobile Sales
Force and the Back Office team are sharing the exact same information at all times. Data is synchronized to the
mobile device and is available for offline viewing.

Azure AD Authentication

Mobile CRM supports Microsoft® Azure® Active Directory (Azure AD) authentication using Epicor ERP credentials,
including support for multi-tenancy configurations where each tenancy uses a different directory in Microsoft
Azure. Note that Windows authentication is not supported for Mobile CRM.

[ Tip For a complete information on how to configure authentication of ERP application users against users
in Azure Active Directory (Azure AD), review either of the below sources:

e Epicor ERP Application Help: System Management > Working With System Management > System
Administration Guide > Manage Epicor ERP > Authentication (User Identity) > Azure AD Authentication

e Epicor ERP 10 Installation guide: Appendices > Azure AD Authentication

10.2.300 83



10.2.300 Feature Highlights 10.2.300 Feature Highlights

84

Sales and Tax Category Options for Quote Lines

The Sales Category and Tax Category fields have been added to the Opportunity/Quote > Add
Opportunity/Quote Line screen to designate which sales category applies to this quote line, and specify a tax
category applied for the part being quoted.

Ability to Specify Tax Liability and Tax Exempt for Customers

The Tax Liability and Tax Exempt fields have been added to Customers > Add Customer screen to search
for and retrieve tax liability values from the backoffice application, or indicate if the customer is entitled to tax
exemption.

Ability to Create Orders from Quotes

Use the Convert to Order command in the Opportunity/Quote Details screen to convert selected quote in
a sales order. Use the Opportunity/Quote Lines screen to select the quote lines you want to include in a sales
order created.

W Note You can convert opportunities/quotes to orders only if you have the Full Office license.

Add/Edit Sales Orders

Use the Add Order command on the Orders screen to add sales orders, and the Edit Order command on the
Order Details screen to edit sales orders. Use the Add Order Line command on the Order Lines screen to
enter new lines and the Edit Order Line command on the Order Lines Details screen to update order lines'
information.

W Note You can add/edit sales orders only if you have the Full Office license.

Order Shipment
Use the Ship command on the Orders Details screen to ship the selected sales orders. You can enter/edit Order
Shipment Lines details on the Order Shipment Lines Details screen.

W Note The Order Shipment functionality is only available if you have the Full Office license.

Customers Map
Use the Map screen to search for customers, identify opportunities while in the area, get travel time and directions
to the customers.

By default the map displays your current location and the nearby customers within a 10-mile radius. You can
change this radius to see more customers.

Use filters to narrow the customer search or switch between the map modes.

When the search is complete, tap the required customer to view the details or get directions. Note the route
displays in the Google Maps app.

Use the Customer List field to see the selected customer on the Customers screen or search for a particular
customer.
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Inventory Search

Use the Inventory screen to search for parts and verify the available inventory in your warehouses to make sure
you have enough stock before creating orders for customers.

By default, all parts are selected.

Use Filters to retrieve part records for a specific warehouse. By default, the main warehouse is selected.

Press any part record to view inventory quantities for the this part on hand and available within the selected
warehouse.

Discount Percentage for Opportunity/Quote

Use the Discount % field to enter the discount percentage for an opportunity/quote. The added percentage
displays on the Opportunity/Quote Details screen.

Credit Hold

Select the Credit Hold check box in the Add Lead or Add Customer screens of the Lead and Customer modules
to indicate if a customer is on credit hold.

[ Note This check box is selected by default. It is cleared after the customer is removed from the credit hold
list in the ERP Application backoffice.

Order Line Comments

Use the following comment fields on the Order Line screen in Order module to define notes that describe
additional aspects of an order line:

e Sales Order Comment

* Pick List/Job Comment

e Pack Comment

e Proforma Invoice Comment

[ Note These comments display on various query windows in ERP Application. They also print out on the
Sales Acknowledgment, Pick List, Packing Slip, AR Invoice, and Pro-Format Invoice.

Use Comments field in the Add Opportunity Line Details form on the Add Opportunity/Quote screen in
Opportunity/Quote module to create comments for a specific line.
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